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10.1 OBJECTIVES 
 
Students will be able to: 
   

•  Create and configure a mailbox 
•  Create and configure a Custom Recipient 
•  Create and configure Distribution Lists 
•  Understand the differences between public, personal, and private folders 
•  Understand how to move mailboxes 
•  Understand how to clean mailboxes 
•  Understand the concepts on tracking messages 

 
10.2  OVERVIEW 
 
As a workgroup manager, the Exchange Administrator may call upon you to assist in many of the 
administrative tasks required to keep messages flowing between users.  This module focuses on teaching 
you the skills required to create and manage mailboxes, custom recipients and public and personal 
folders.  You will also learn how to track a message between users. 
 
10.3  WHAT IS EXCHANGE 
 
As an IT professional, you know that Exchange is one of the most popular components of Microsoft's 
BackOffice package, which runs on Microsoft's NT Server operating system.  But functionally, how 
would you define Exchange?  Is it an e-mail system, a groupware product, something in between, or 
something altogether different?  Exchange does sport some characteristics of each of these possibilities: 
 

•  An e-mail system? You are no doubt familiar with electronic mail, or e-mail, systems, which 
have become one of the dominant communication methods over the past couple of decades.  You 
can use e-mail to communicate within your company or with people across the planet.  Exchange 
is one of the most popular e-mail systems in the world, but it is much more than a simple e-mail 
system.  

 
•  A type of groupware?  In the 1980s, the term groupware became popular. The term was 

interpreted in various ways, but it generally meant a product that could be used to create 
collaborative applications, in which people shared access to a collection of centralized 
documents. Groupware has evolved to not only include shared information, but also workflow 
tracking, process automation, and workgroup-based knowledge management.  Exchange lets you 
store virtually any type of document within the Exchange system, which in turn allows the 
document to be shared among a wide variety of people.  Exchange can also automatically send 
copies of documents to different physical information stores, making the use of shared documents 
across an organization much more efficient. Sharing documents in a common storage area is only 
one aspect of groupware.  Exchange includes a full collection of application samples and 
development tools with which to create collaborative, automated applications.  
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•  A common repository of information?  One thing that Exchange must do is store information.  
Even if you are using Exchange only for e-mail, Exchange still must store the messages sent in a 
logical structure.  Through the use of shared information stores, you can extend the capabilities of 
Exchange to act as a general repository for a wide variety of information, including documents, 
presentations, and multimedia.  You can leverage Exchange's capabilities to provide a logical 
storage system for all your complex data.  You can then use other Exchange features to provide 
distributed storage for your data, replication of data between different Exchange Servers, and 
varying levels of secure access to the data. 

 
•  A platform for creating interactive applications?  You can use Exchange as the basis for 

creating applications and systems to address the specific needs of your organization.  For 
example, you can create forms that extend the capabilities of a simple message and attach 
application logic to these forms.  Then you might configure Exchange to route these forms to 
specific users or destinations, where they can undergo further modification.  Additional tools 
allow you to access and manipulate the information stored in Exchange or to take advantage of 
Exchange's Directory and Delivery Services.  

 
•  A scalable and extensible platform?  Many people use Exchange's messaging and groupware as 

is.  Others purchase other applications that plug into Exchange and take advantage of its 
technology to provide best-in-class applications. 

 
As you can see, Exchange is a multifaceted and complex product.  By the time you complete this book, 
you will have a full understanding of how to use Exchange to implement all these types of functionality.  
You will be able to exploit the capabilities of Exchange to their fullest extent. 
 
10.4  BASIC TERMS 
 
Before moving to the specifics of Exchange, you need to understand some basic concepts that form its 
foundation. 
 
10.4.1  CLIENT/SERVER SYSTEMS 
 
You might be using Exchange to replace an earlier e-mail system that is already installed at your 
company, such as Microsoft Mail.  The key difference between Exchange and some of these earlier 
systems is that Exchange is a client/server system rather than a shared file system. 
 

 
Figure 10-1.  A shared file e-mail system 
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A shared file e-mail system, as shown in Figure 10-1, works fairly simply.  Someone sending an e-mail 
places the message in a shared location.  Someone attempting to receive an e-mail checks the shared 
location for any new messages.  These types of systems are inherently passive, in that it is up to the 
messaging software running on the client machine to carry out the operations of the e-mail transaction.  In 
contrast, the Exchange system, shown in Figure 10-2 is a client/server system.  Each individual client 
interacts with the messaging database on the Exchange Server. 
 

The client/server process is active; it dynamically receives the message and delivers it to a location that 
individual users can access to retrieve their messages.  The client does not have to do all the work.  The 
server does most of the work in the system. 
 
For example, each Exchange Server: 
 

•  Manages the messaging database  
 
•  Manages the connections to other Exchange Servers and messaging systems  
 
•  Indexes the messaging database for better performance  
 
•  Receives new messages and transfers them to their destinations  
 

To provide these services and more, Exchange Servers are typically based on more powerful server 
machines than shared file e-mail systems, which means that a client/server system such as Exchange is 
inherently more scalable than a shared file system.  In fact, as you see later in the chapter, the server-
based agents that implement Exchange can also provide a higher level of security, reliability, and 
scalability than a simple shared file e-mail system can.  All these features allow Exchange to support 
many more users than simple file-based systems can. 
 
As the name implies, a client/server system has two logically and physically distinct components: a client 
and a server.  The client and the server use a specific interface to cooperate.  The fact that Exchange 
Server distributes functions between the client and the server means that more processing power is 
available systemwide for messaging in general.  In comparison, a shared file system depends on the client 
to constantly check and pull mail, a process that can result in poorer performance as well as heightened 
network traffic on a workstation client.  Many types of clients can be used to access the power of 
Exchange Server. 
 

 
Figure 10-2.  The Exchange client/server system 



Air Force Workgroup Management Course – Module 10 
 

 

 
1 January 2003 

5 

 Many clients can access a server at the same time.  As a result, a server must be implemented with an 
architecture that can simultaneously handle many types of requests from many sources.  The requirement 
to service many clients is one of the primary factors that led to the architecture used to implement 
Exchange, which implements several separate processes in the server that cooperate to handle client 
requests.  These server processes and the way that they interact are detailed later in this chapter. Each 
Exchange process is responsible for implementing one type of task.  This means that Exchange can 
execute different functions simultaneously rather than linearly, as would be found in a monolithic, single-
process messaging architecture.  The overall result is that Exchange Server can be a robust system and an 
improvement over legacy messaging architectures.  
 
10.4.2  MESSAGING SYSTEMS 
 
E-mail is certainly a type of message, but an electronic messaging system can provide more functionality 
than just delivering e-mail.  When you talk about a messaging system, you are describing a more 
generalized process that can be used to deliver many different types of information to many different 
locations.  A messaging system has several specific characteristics.  First, it involves the participation of 
at least two parties: the sender and one or more recipients.  When a sender dispatches a message, the 
sender can count on the guaranteed delivery of the message.  If a message cannot be delivered to the 
recipient immediately, the messaging system continues to try to deliver the message.  If, for some reason, 
the messaging system cannot deliver the message, the least it will do is to inform the sender of this failure 
so that the message can be re-sent at a future date. 
 
Although a standard messaging system can guarantee the reliable delivery of messages, it cannot 
guarantee exactly how long a message will take to be delivered.  The sender and recipient(s) of a message 
can be located near each other or very far away from each other.  A letter sent from New York to Chicago 
usually arrives faster than a letter sent from New York to Tokyo because of the distances involved.  But 
under certain circumstances, the letter sent to Tokyo may arrive before the letter sent to Chicago.  Even if 
a letter arrives in Chicago faster than it arrives in Tokyo, it might not be read and acted on by the recipient 
sooner than the Japan-bound message.  The uncertainty implicit in this process is due to the asynchronous 
nature of a messaging system.  In an asynchronous system, two related events are not dependent on each 
other; the sending of a message and the receipt of the message are not tied together in any fixed span of 
time. 
 
When you send a message in Exchange, the Exchange Server immediately receives it, and you can go on 
to another task.  You don't have to wait for the message to be delivered, wherever it is going.  Guaranteed 
delivery gives you confidence that a message will be delivered, but the asynchronous nature of messaging 
systems makes it impossible for you to know exactly when it will be received.  This fact makes 
messaging systems ideal for some types of interactions and less than perfect for other types. 
 



Air Force Workgroup Management Course – Module 10 
 

 

1 January 2003 

6 

 

 
Messaging systems, in general, are implemented with a two-stage architecture, which includes a 
distribution hub and a number of clients.  This structure is shown in Figure 10-3.  The clients in the 
system act as the senders and recipients of messages.  Each client connects to a single distribution 
messaging server, which receives the messages sent by the client and collects the messages sent to the 
client.  If the system has more than one messaging server, the servers coordinate the exchange of 
messages between them with no additional interaction from the sender or the recipient.  To make this 
distribution possible, some type of common directory must associate each client with a particular 
messaging server.  In Exchange, each Exchange Server acts as a distribution-messaging server, and the 
directory information used to distribute information is shared across multiple servers. 
 
NOTE : Keep in mind that in a messaging system, the distribution hubs described in this section are 
logical entities.  All clients must access a distribution hub to interact with the system, but the particular 
hub could be associated with a different physical location at different times.  
 
The last characteristic of a messaging system is its information store.  Because the messages in a 
messaging system are delivered asynchronously, and because the delivery is guaranteed, a messaging 
system must have a place to store messages.  These message stores might hold messages only until a 
recipient retrieves them, or they might hold messages in archives for individual recipients.  In some 
advanced messaging systems, such as Exchange, message stores can be used to hold information that can 
be shared by many recipients.  The ability to share information among users improves efficiency in a 
network environment.  Being able to share that information in a common storage area extends the 
capabilities of the messaging system into groupware functionality, which may include collaborative 
applications. 
 
Now that we have reviewed the characteristics of messaging systems, you can see how this description 
can be applied to an Exchange system.  Exchange can be used as a generic messaging system because you 
can access its services and information stores in a wide variety of ways—even from outside the Exchange 
environment. 
 
 
 
 
 

 
Figure 10-3.  A messaging system
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10.5  THE ORGANIZATION OF AN 
EXCHANGE ENVIRONMENT 
 
An Exchange environment is built on multiple structural levels, as 
shown in Figure 10-4.  Each level has specific features and 
supports different types of interactions with the other levels in the 
environment. 
 
Exchange offers a hierarchical architecture upon which to develop 
your directory of mailboxes and messaging servers.  The top three 
levels of the Exchange environment—the organization, the sites, 
and the servers—make up the topology, or overall structure, of the 
environment.  The organization, sites, and servers describe the 
arrangement of the components that make up an Exchange 
hierarchy.  The other elements of Exchange identify mailboxes, 
folders, storage areas, connectors, and other messaging resources 
available to Exchange users established in the directory. 
 
10.5.1  ORGANIZATION 
 
The top level in an Exchange environment is referred to as the 
organization.  An organization contains all the elements in an Exchange environment.  It is the starting 
point for the hierarchical directory structure that specifies your Exchange environment.  The boundaries 
of the organization define the boundaries of your Exchange environment.  You cannot see anyone outside 
your organization in this directory structure without specifically creating a link to that person.  This does 
not prevent an Exchange user from sending messages to external systems if Exchange has taken 
advantage of connectors such as the Internet Mail Service, an X.400 or FAX connector. 
 
Exchange Server is a messaging system that sits on top of Microsoft Windows NT Server.  The NT 
Server environment offers single logon authentication through its domain architecture and subsequent 
trust relationships. NT domains are groups of NT Servers, and a common directory of users is allowed to 
access any specific NT domain.  When one domain trusts a second domain, the second domain's users can 
access the first domain's servers.  
 
Exchange Server's hierarchy is outside yet integrated with the NT domain structure.  An Exchange 
organization (the object at the top of the Exchange system's hierarchy) can span multiple NT domains.  
An Exchange site (the next-level object in the Exchange system hierarchy) must have some special 
security relationships set up that allow it to span multiple NT domains. 
 
10.5.2  SITES 
 
The site is the basic administrative unit of the Exchange environment.  Most of the administrative 
functions within Exchange can be performed at the site level, which means that you can set parameters 
and defaults for all the lower levels in the Exchange environment on a site-by-site basis.  Although rules 
and policies are implemented on the basis of the organization of your company, site implementation is 
typically based on the physical infrastructure.  An Exchange site is usually separated from other sites by 
WAN links so that intra-site bandwidth consumption is kept to a minimum across low-bandwidth links. 
 

 
Figure 10-4.  The Exchange environment,          
as seen in the Exchange Administrator 
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A site cannot span multiple Windows NT domains unless the domains have established a trust 
relationship, so the topology of your Windows NT network will, to some extent, determine the topology 
of your Exchange environment. 
 
Exchange Servers generate more network traffic within a site than between sites.  Servers within sites 
frequently interact in order to synchronize and replicate information.  For this reason, your site will 
operate most efficiently if it is contained within a single local area network (LAN) or a high-speed wide 
area network (WAN).  Balancing the physical requirements of sites with the organizational requirements 
of distributed companies is one of the high arts of designing and implementing large Exchange systems. 
 
10.5.3  SERVERS 
 
Server is the term used in the Microsoft Exchange topology to refer to an individual machine that has the 
Microsoft Exchange Server messaging application installed and running on it.  A server is contained 
within one—and only one—site.  The name of the server typically is the same as the name of the 
Windows NT computer that hosts the Exchange application. 
 
There are no hard and fast rules as to how many servers you should have within a particular site.  The size 
of the machine acting as the server will have some bearing on how many users and how large a store can 
be supported on the machine.  In addition, when individual users on the same server communicate 
through Exchange, there is no need to use extra network bandwidth to enable the communication, because 
there is no need to move the message between separate physical machines.  Some thought should be put 
into which servers to place users on.  If users are grouped according to how they interact with each other, 
the Exchange Server's performance, and even the performance of the entire messaging system, can be 
improved.  In terms of using Exchange, however, there is one critical component of the Exchange 
organization: the recipient. 
 
10.5.4  RECIPIENTS 
 
As the name implies, a recipient is an entity that can receive an Exchange message.  Most recipients are 
associated with a single, discrete mailbox, although this mailbox can be represented by several addresses, 
depending on the addressing types implemented within Exchange.  Each recipient's mailbox is associated 
with a single server. Public folders and distribution lists are also recipients in Exchange. 
 
The Global Address List, which is the master list of recipients, custom recipients, distribution lists, and 
public folder addresses, is maintained for an entire Exchange organization.  For example, a recipient on a 
server in Tokyo (in the Japan Exchange site) is located in the Global Address List along with a recipient 
on a server in London (in the United Kingdom site).  When a mailbox is moved from one server to 
another, the Global Address List appears unaffected.  When a mailbox is created for a user in Exchange, 
the mailbox becomes an Exchange recipient.  If a mailbox does not exist in the Exchange organization but 
is available through connectors to another messaging system, the administrator can configure a custom 
recipient so Exchange users can send mail to it.  A custom recipient has an e-mail address that shows up 
in the Global Address List but has no Exchange mailbox.  Custom recipients can receive e-mail from 
Exchange users, just like standard Exchange recipients, after their addresses are defined in the Exchange 
system's Global Address List.  Through the use of custom recipients, you can integrate external recipients 
into the address list of your Exchange system. 
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10.5.5  ADDRESS LISTS 
 
An address list is simply a list of Exchange recipients.  The Global Address List is the list of all Exchange 
recipients in the entire Exchange organization.  The recipient is the lowest level of the Exchange 
hierarchy.  An Exchange system can have hundreds of thousands of recipients, making it hard to manage 
when a user is merely trying to locate an individual recipient's name.  Exchange uses address lists to hold 
and organize the names of the recipients associated with the system. 
 
The primary purpose of an address list, from a user's point of view, is to provide access to an e-mail 
address for a recipient. E-mail addresses can be somewhat cryptic.  Various legacy-messaging systems 
have restrictions for the length of the user's mailbox name; some administrators assign puzzling mailbox 
names, too.  All in all, it is difficult to guess a user's e-mail address.  When the Exchange Administrator 
creates a custom recipient, the name of the person—not a cryptic e-mail address—shows up in the Global 
Address List.  This makes it easier for Exchange users to send mail to custom recipients. 
 
Exchange maintains a Global Address List that contains all the recipients in the entire system.  Individual 
users can create their own personal address books.  Personal address books can contain a portion of the 
Global Address List, as well as other custom addresses added by the user, to make it easier to access the 
most frequently used addresses.  
 
10.5.6  CONNECTORS 
 
You should understand one more piece of the Exchange topology before moving on.  A connector is a 
piece of software that acts as a gateway to another Exchange site or to a non-Exchange mail system.  By 
using a connector, you enable the Exchange system to interact directly with a foreign e-mail system, as 
though its users were part of your Exchange system.  Connectors can integrate foreign address lists into 
the Global Address List, enable message exchange, provide access to shared messaging folders, and make 
available other functions.  Some connectors simply enable a consistent mail-forwarding and receipt 
operation.  Not only can a connector provide linkage between Exchange and other messaging systems, but 
a connector can be extremely useful if you are in the process of migrating to Exchange or connecting to 
non-messaging systems such as fax or voice mail. 
 
10.6  STORAGE 
 
Exchange uses several types of stores to hold the messages that make up the information environment of 
Exchange.  Within the messaging stores, Exchange organizes the messages themselves in folders. A 
folder has the same relationship to its messages that a directory in a file system has to its files.  Because 
Exchange manages the storage of its own data, there is not a strict one-to-one relationship between a 
folder in an Exchange store and a directory in the operating system.  Exchange systems can use three 
types of stores: Public Information Store, Private Information Store, and Personal Information Store. 
 
The Public Information Store is a database that can exist on an Exchange Server.  This database stores 
public folders, indexes their contents, and assists in the replication of the folders with other Exchange 
Servers.  
 
The Private Information Store is a database that usually exists on an Exchange Server.  The Private 
Information Store contains all the mailboxes of every Exchange user associated with that Exchange 
Server.  The Private Information Store manages the data within the mailboxes, tracking deleted messages 
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and mailbox sizes and assisting in message transfers.  The Private Information Store is sometimes 
considered the holder of private folders, which is another name for the individual folders within 
mailboxes. 
 
10.6.1  PUBLIC FOLDERS 
 
As the name implies, a public folder is accessible to more than one user.  You can define the specific 
security restrictions on a public folder to limit the types of users who have access to it.  Public folders are 
the basis of a great deal of Exchange's functionality. 
 
Like the Global Address List, public folders appear to be a single entity to an Exchange user.  When 
exploring public folders, the user does not need to determine which Exchange Server houses which public 
folder.  Instead, the user simply explores a single hierarchy of public folders. 
 
Public folders are ideal places to keep information that is accessed by large numbers of people.  If, for 
example, your organization has marketing materials or human resources policies that you want to make 
available to everyone as soon as they are created, you can put them in a public folder.  Public folders are 
maintained in a separate Public Information Store.  When you install an Exchange Server, you have to 
specify locations for the Public Information Store and the Private Information Store.  Each store acts as a 
database for all the objects that it contains: mailboxes for the private store and public folders for the 
public store.  
 
The reason for this separation between the public store and the private store lies in the way that Exchange 
automatically treats the information in the public store.  Because everyone on what could be a widely 
dispersed site can access public folders, Exchange allows you to set up automatic replication of the 
contents of public folders.  Exchange handles the replication of documents in a public folder with no 
intervention on the part of an administrator after the replication is defined.  Users who request a document 
in a public folder retrieve it from the closest copy of the public folder, rather than all users having to reach 
out for a single copy of the requested document.  In this way, public folders help expand the scalability of 
Exchange by reducing the bandwidth requirements for the access of common documents. 
 
10.6.2  PRIVATE FOLDERS 
 
A private folder holds information that is available only to a single Exchange user and to others to whom 
that user has granted access permissions.  A private folder is a secured folder component within a mailbox 
for an Exchange recipient. 
 
Exchange maintains private folders and their container mailboxes within the Private Information Store of 
the associated Exchange Server.  The word "secured" refers to the fact that an Exchange user must have 
an account and password to access each mailbox.  That security does not exclude mailboxes from being 
managed in Exchange. Like Public Information Stores, Private Information Stores are included in 
standard Exchange backup and recovery operations.  
 
Exchange users are not limited to Outlook or Exchange clients.  Private stores can also be accessed 
through POP3 and IMAP4, which are Internet mail protocols, if the Exchange environment is configured 
to allow those types of access.  When Exchange is configured for these protocols, a POP3 or IMAP4 
client can be used in place of a standard Exchange client. 
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10.6.3  PERSONAL FOLDERS 
 
A personal folder is a folder that has been taken out of the Exchange Server system and placed in a 
location that is controlled by an individual user.  Typically, a personal folder is kept on the user's personal 
machine.  This arrangement can be very handy because it allows users to access information from an 
Exchange client when they are not connected to the Exchange Server. 
 
Personal folders are created when a user maintains Exchange data in a separately managed database. 
Personal folders are typically used as a separate place to retain mailbox contents.  In addition, a user can 
replicate the contents of public folders to their personal folders. 
 
After materials are placed in a personal folder, they are the exclusive responsibility of the user.  Other 
users cannot access the materials in a personal folder, so if users create or modify any of the documents in 
the personal folder, they have to explicitly place these documents in a private or public folder in order to 
put them back under the care of an Exchange Server. Exchange Servers typically include backup and 
recovery services.  When mail is placed outside an Exchange Server into a personal folder, users must 
handle any backup and potential recovery operations on their own. 
 
10.7  SERVER PROCESSES 

 
Figure 10-5.  Exchange Server processes in the 
Windows NT Services window 
 
From the outside, Exchange looks like a single, monolithic software system.  Internally, Exchange uses 
four key services to implement functionality: directory service, information store service, message-
transfer agent service, and system attendant service.  A service is a piece of software that runs in the 
background, performing its tasks without requiring any specific administrative intervention.  For 
Exchange, agents are Windows NT Server processes known as services, as shown in Figure 10-5. 
 
When you install Exchange, you must specify an NT account that the Exchange Server processes will 
utilize to access the NT Server system.  NT accounts can be granted varying levels of NT Server access.  
When an Exchange Server service accesses the NT Server, it must be able to act as part of the NT system.  
The NT account that you specify as the Exchange service account will be granted extended access to the 
NT Server in order to perform this function on the behalf of Exchange. 
 
All Exchange services normally utilize the same service account.  The service account and its agents act 
as an intermediary between Exchange users and operating system files, so the service account requires a 
much higher level of access to the operating system and the server files than a standard user does.  The 
following sections describe the four basic Exchange services, which are illustrated in Figure 10-5. 
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10.7.1  DIRECTORY SERVICE 
 
Earlier in this chapter, you learned that the Exchange Directory contains a listing of all the main objects 
known to an Exchange organization, including recipients, custom recipients, and distribution lists.  Each 
Exchange Server contains a Directory object that lists the server's contents.  The object is typically called 
Server Recipients.  The Directory Service was developed to link all the different Exchange Server 
Directory objects into a cohesive Global Address List, to replicate the information throughout the 
Exchange system, and to resolve names to mailboxes.  The Directory Service of Exchange acts as the 
intermediary to the physical store of the Directory objects on each Exchange Server.  When a request for 
an address comes in, the Directory Service resolves the request to the correct Exchange Server and 
Directory object and then returns the address that can be used to access the recipient's location.  For this 
reason, the Directory Service is involved in most Exchange interactions. 
 
By providing a single interface to all Exchange objects, the Directory Service also makes it easier to 
manage all Exchange entities from a single interface, such as the Exchange Administrator.  The Directory 
Service agent is called Microsoft Exchange Directory in the Windows NT Services window. 
 
10.7.2  INFORMATION SERVICE STORE 
 
The information stores, just like the Exchange Directory, are kept as database files that are managed by an 
Exchange Server.  The Information Store Service is responsible for storing and retrieving information 
from any of those stores.  The Information Service is involved in sending messages, and it is also 
involved in automatic functions of Exchange, such as replication.  The Directory Service agent is called 
Microsoft Exchange Information Store in the Windows NT Services window. 
 
10.7.3  MESSAGE-TRANSFER AGENT SERVICE 
 
The most active part of an Exchange Server is the Message-Transfer Agent (MTA) Service.  When the 
MTA shuts down, the Exchange Server no longer moves mail through the system.  The MTA is 
responsible for coordinating the transfer of messages between Exchange Servers.  It acts as a traffic cop 
and a crossing guard combined, directing messages to their next destinations as well as ensuring that the 
messages arrive safely.  If a message is sent from one user on an Exchange Server to another user on the 
same server, the MTA is not involved in the transaction.  The Directory Service agent is called Microsoft 
Exchange Message-Transfer Agent in the Windows NT Services window. 
 
10.7.4  SYSTEM ATTENDANT SERVICE 
 
The System Attendant (SA) is the background manager for the Exchange system.  The SA maintains the 
routing tables that are used by the MTA for message delivery, makes sure that the directories on separate 
servers are consistent, monitors the connections between servers, and collects feedback that is used by 
other monitoring tools.  These unseen tasks are vital to the continuing successful operation of your 
Exchange environment.  The SA is called Microsoft Exchange System Attendant in the Windows NT 
Services window. 
 
Additional Exchange services can be running on your system because some optional features of Exchange 
create their own services, such as a key management server service, which provides an additional level of 
security for your Exchange system.  To show you how these agents work together, the last section of this 
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chapter walks you through a typical user interaction with Exchange and explicitly describes the services 
that are used throughout the process. 
 
10.8  HOW EXCHANGE WORKS 
 
To understand how the different server processes work together, let's take a high-level view of 
the process of sending a message and the ways in which these services participate in this process: 
 

 
1. A user creates a message and sends it. 
 
2. The Exchange Server receives the message, and the Information Store Service stores it on the 

receiving Exchange Server.  By storing the message immediately, Exchange in effect guarantees 
the partial completion of the message-delivery process.  Regardless of what problems occur after 
this point, the message has been safely received and stored on an Exchange Server, so corrective 
actions can be implemented with no additional user interaction.  
 

3. The Information Store Service queries the Directory Service to determine where the message 
should be sent. 

 
4. If the message is addressed to a recipient whose mailbox is on the same Exchange Server, the 

Exchange Information Store Service moves the message directly into the recipient's mailbox, and 
the delivery process ends.  

 
5. If the message is addressed to a recipient whose mailbox is on a different Exchange Server, the 

Information Store Service transfers the message to the MTA Service.  
 

6. The MTA stores the message in a message-transfer database.  Just as the information store 
initially stores a message when it is received to act as a fail-safe, the MTA stores a message so 
that it can handle any delivery issues without further interaction with other services.  When the 
message is successfully sent, the message is deleted from the message-transfer database.  

 

 
 
                   Figure 10-6.  Process flow and Exchange Services 
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7. Upon receiving the message, the MTA queries the Directory Service to determine whether the 
recipient is local or remote.  

 
8. If the recipient is remote, the MTA determines how to best route the message: via a remote 

procedure call (RPC) or a connector.  The MTA then delivers the message to the remote MTA.  
 

NOTE: An RPC is a session layer Application Programming Interface (API) that is used to make 
remote applications appear as though they are working locally.  Much of the interaction of 
Exchange—whether between client and server, or between server and server—uses RPCs.  
 

9. The remote MTA queries the Directory Service to determine whether the recipient is local or 
remote. 

 
10. If the recipient is local, the MTA hands the message off to the information store, which then 

queries the Directory Service, places the message in the recipient's mailbox, and notifies the 
recipient's client.  

 
11. If the recipient is not local, the MTA Service determines the best connection to use to deliver the 

message to the recipient's server and delivers the message to the information store of the target 
server, which continues the process of identifying the eventual local server for the recipient.  

 
You can see from this discussion that the agents used by Exchange have the overall effect of dividing the 
operations of Exchange into circumscribed arenas.  The Information Store Service handles all storage 
operations, from storing an incoming message temporarily to transferring a message to the MTA to 
delivering a message to a recipient's mailbox.  When a message is handed off to the MTA, the 
Information Store Service that gave the message to the MTA is relieved of further proactive tracking of 
the message. The MTA explicitly notifies the Information Store Service if any subsequent problems occur 
with the delivery of the message. 
 
The use of services in Exchange makes it easier for developers to modify existing functionality and to add 
new functionality to Exchange.  By focusing on the specific tasks for each service, Exchange can 
optimize the server to deliver performance and functionality without interfering with the rest of the 
Exchange product.  By isolating Exchange users from directly interacting with the storage files used by 
Exchange, the agents allow an administrator to implement a more robust security scheme for information 
contained in Exchange stores than is available for normal Windows NT files.  The Exchange information 
stores act as a database so that Exchange itself uses a single operating system file for the storage of 
information but provides access to only a part of it for each user, as appropriate.  For most users, the 
separation of actions among services is transparent, but as an Exchange Administrator, you need to 
understand exactly how Exchange and its services respond to user requests.  Exchange services raise 
Exchange to the level of an enterprise product by providing the isolation necessary for enterprise 
scalability. 
 
10.9  ADMINISTRATING EXCHANGE SERVER 
  
10.9.1  STARTING EXCHANGE ADMINISTRATOR 
 
Exchange Administrator is a sophisticated program that allows you to manage all the components of an 
entire Exchange organization from a single location.  The program is installed when you perform a typical 
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or custom installation of Exchange Server 5.5.  You can also install it separately on any computer running 
Microsoft Windows NT Workstation 4.0 or Server 4.0 or later. 
By default, Exchange Administrator is installed in the Exchange Server program group.  You can get to it 
by clicking on the Start menu, choosing Programs, choosing Microsoft Exchange, and then choosing 
Microsoft Exchange Administrator. 
 
Whenever you run Exchange Administrator, the program must connect to a specific Exchange Server in 
your organization.  When you start Exchange Administrator, it prompts you to connect to a server.  If you 
want to connect to another server, you can go to the File menu, choose the Connect to Server option, and 
then provide the name of the desired Exchange Server.  
 
In order to administer an Exchange system with the Administrator, you must be logged on to Windows 
NT under a domain user account with administrative permissions in the Exchange site where the server is 
located.  Until you specifically grant other user accounts permissions to administer Exchange Server, the 
only account with permission to do so is the account under which you were logged when you installed 
Exchange Server 5.5 and the Site Services account.  
 
You can grant a user account different types of administrative permissions.  If you grant permissions to a 
site, that user account can add mailboxes and administer recipients.  If you grant permissions to a 
configuration container, that user account can configure the servers, connectors, and site properties.  If 
you want to grant full permissions to an account at the site level, you grant permissions to both the site 
and the configuration container.  
 
Permissions are generally granted through the use of roles.  A role is a group of individual permissions 
within Exchange that can be applied to any user.  The roles that can be assigned are Admin, Permissions 
Admin, Service Account Admin, View Only Admin, User, Send As, and Search. Roles are a timesaving 
device, but you should understand what each role means when it is applied to an account.  The Service 
Account Admin role grants the most wide-ranging permissions.  The View Only Admin role grants the 
lowest level of permission.  To make a user account able to administer the organization, use the Admin 
role.   
  

                                                
 
                                                           Figure 10-7.  Choosing an Exchange 
                                                           Server 
 
The first time you run Exchange Administrator on a newly installed server, you encounter the Connect to 
Server dialog box, shown in Figure 10-7.  You can enter the name of the server to which you want to 
connect, or you can browse the network to find the server.  You can also specify that the selected server 
be the default connection.  If you choose this option, you do not see this dialog box when you run 
Exchange Administrator in the future; instead, you connect to the default server automatically.  Then you 
can connect to different servers from within Administrator. 
 
NOTE   You can connect to only one Exchange Server at a time within a single instance of Exchange 
Administrator.  However, you can run multiple instances of Administrator on the same computer and 
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connect to a different server with each instance.  To do so, run Exchange Administrator a second time or 
choose Connect To Server from the File menu of Administrator.  
 
10.9.2  EXPLORING THE MAIN ADMINISTRATOR WINDOW 
 
Exchange Administrator provides a graphical view of all the resources and components of an Exchange 
organization.  No matter how many sites and servers you have set up, you can manage them all from a 
single Administrator window, as shown in Figure 10-8.  Use this window to navigate the Exchange 
organizational hierarchy and perform the various tasks associated with Exchange administration. 
 

                                 
                         
                                                      Figure 10-8.  Finding your way around the  
                                                      main Administrator window 
 
The first thing to notice is that the window is divided into two panes.  The pane on the left is called the 
container pane.  The pane on the right is called the content pane.  These panes work much like the 
familiar dual-paned Windows Explorer.  When you select a container in the container pane, its contents 
are displayed in the content pane. 
 
Exchange Server is a great example of an object-based, hierarchical directory environment.  All the little 
bits and pieces that make up Exchange are objects that interact with one another to some degree.  All the 
objects that you see in the container and contents panes can be divided into two types: 
 

•  Leaf objects A leaf object represents a messaging resource or account.  Some common leaf 
objects with which an administrator works daily include mailboxes, distribution lists, and 
connectors.  These objects do not contain other objects. Leaf objects appear only in the content 
pane of Administrator.  

 
•  Container objects Container objects can contain both leaf objects and other container objects.  

The container pane of Administrator displays only container objects.  Container objects can also 
appear in the content pane.  Container objects are used to logically group all the objects that make 
up an Exchange organization.  An administrator uses the container objects to organize the tree 
and then to navigate through it.  Two container objects are Organization and Site.  In fact, if you 
take a close look at the container pane shown in Figure 10-9, you'll see that each level of the 
Exchange hierarchy that is displayed.  
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The actual objects that you encounter in Exchange can be confusing if you do not know what their 
functions are.  The top of the hierarchy in the container pane is the Exchange organization.  It has a small 
globe icon with a letter in front of it.  All other Exchange objects are contained within the organization. 
The second container that you run into is the Address Book Views container.  This holds the various 
configurations that you designate for the Global Address List. 

 
The next container in the hierarchy is usually Folders.  The Folders container holds the public folders 
hierarchy and properties, but not their contents.  It also contains the system folders, a list of folders that 
Exchange users do not see.  The system folders hold the Offline Address Book and other system 
configuration objects. 
 
After that, you see the Global Address List (GAL).  The GAL is the container of the recipient list for all 
servers within the Exchange organization.  The GAL is a separate list from the server recipients because it 
incorporates all recipients and replicates between servers in order to be updated consistently. 
 
Finally, you see all the site containers, listed by their names.  Each site contains further containers for:  
 

•  Servers The actual Exchange Servers  

•  Protocols The protocols that the site is configured for  

•  Monitors The tools that an administrator can create and configure to watch Exchange messaging 
activity  

 
•  Directory replication The configuration of directory updates  

•  Connections The connectors that are configured for the site  

•  Add-ins The additional components plugged into Exchange  

•  Addressing The address templates and generators for consistent names  

 
Figure 10-9.  Viewing the Exchange hierarchy in the 
container pane 
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10.9.3  CREATING AND MANAGING RECIPIENTS 
 
Sending and receiving information is the foundation of messaging, groupware, and, of course, Exchange 
Server.  In this chapter, we start looking at the message transfer process within an Exchange system.  We 
examine the mailbox repositories, how those mailboxes and other network resources are Exchange 
recipients, and how to manage those recipients.  Exchange Server is based on a multitude of messaging 
components, but with some analysis, it becomes apparent how those components interact to create an 
enterprise-wide messaging system.  
 
Recipients are objects in Exchange that reference resources that can receive messages.  Such a resource 
might be an inbox in the Private Information Store where one of your users gets mail, a public folder 
where information is shared among many users, or even a newsgroup on the Internet. 
 
However, no matter where a resource resides, a recipient object for that resource is always created on an 
Exchange Server in your organization.  One of your main tasks as an administrator is to create and 
maintain these recipient objects.  This chapter explains how to create and manage various types of 
messaging recipients; it also discusses tools that allow you to search for and organize recipients 
 
10.9.3.1  UNDERSTANDING RECIPIENT TYPES 
 
It is tempting to think of a recipient as a mailbox or simply an object that can receive a message, and as 
you administer your organization, it may be convenient to take that view.  But it is important to 
understand how the underlying architecture affects how you work with recipients in Exchange.  
 
In Exchange, a recipient object does not receive messages.  Instead, a recipient object is a reference to a 
resource that can receive messages.  This is a subtle but important distinction. Recipient objects are 
contained in and maintained by the Directory Service.  The resources that those objects reference could be 
anywhere. One resource might be a mailbox for a user in your organization.  A mailbox resource would 
be contained in the Private Information Store of the associated Exchange Server and maintained by its 
Information Store Service. Another resource might be a user on the Internet.  In this case, the recipient 
object would contain a reference to that resource, along with rules governing the transfer of messages. 
 
Four types of recipient objects are available in Exchange. 
 

•  Mailbox A mailbox is a private storage area, in which an individual user can send and receive 
messages.  Each mailbox is typically associated with a Microsoft Windows NT user account and 
a single user within your organization.  A mailbox recipient object references that mailbox and is 
used to configure its properties.  

 
•  Custom recipient A custom recipient is a pointer to a mailbox in an external messaging system 

linked to a person outside the organization.  This type of recipient points to an address to be used 
to deliver messages sent to that person and the properties that govern how those messages are 
delivered.  Custom recipients are most often used for connecting your organization to foreign 
messaging systems, such as Microsoft Mail (also known as MSMail), Lotus cc:Mail, or the 
Internet.  An administrator creates custom recipients so that often-used e-mail addresses are 
available in the Global Address List (GAL) as real names.  This makes it easier to send mail 
because users do not need to guess at cryptic e-mail addresses.  
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•  Public folder A public folder is a public storage area, typically open to all users in an 
organization.  Users can post new messages or reply to existing messages in a public folder, 
creating an ongoing forum for discussion of topics.  Public folders can also be used to store and 
provide access to just about any type of document.  The concept of a public folder as a recipient is 
difficult to grasp because the repository for information is shared.  One way that a public folder is 
used as a recipient is when it is configured for Network News Transfer Protocol (NNTP) 
newsfeed.  In this scenario, the information from the newsgroup is sent to the public folder 
recipient and then viewed by Exchange users in the organization.  

 
•  Distribution list A distribution list (DL) is a list of other recipients.  Messages sent to a 

distribution list are redirected and sent to each member of that list.  Distribution lists can contain 
any combination of the other types of recipients, including other DLs.  These lists allow users to 
send messages to multiple recipients without having to address each recipient individually.  A 
typical distribution list is one for "Everyone."  All Exchange recipients are made members of the 
Everyone DL.  When a public announcement is made, the sender of the announcement simply 
selects the Everyone DL and is not forced to select every user's mailbox from the GAL.  

 
Although a public folder is a type of recipient, it is composed of many more functions than just the 
transfer or receipt of messages.  This chapter focuses on message sending and receiving by the three 
recipient types other than public folders: mailboxes, custom recipients, and distribution lists.  
 
10.9.3.2  UNDERSTANDING RECIPIENT CONTAINERS 
 
Recipients can be located anywhere—in an Exchange Information Store on a particular Exchange Server 
or on a foreign messaging system.  Recipient objects reference those recipients and appear in specific 
places within Exchange Administrator.  These specific places are called Recipient containers. Exchange 
Server uses Recipient containers to construct address books, and Exchange Administrator uses Recipient 
containers to organize recipient objects for easier administration. 
 
NOTE:  The word container makes it sound as though recipient objects are actually stored inside 
recipient containers. This is not really the case.  A recipient container is merely a group of references to 
recipient objects.  Recipient objects all have their specific places within the Exchange Directory 
Information Tree (DIT).  However, a single recipient object might be viewed in multiple recipient 
containers within Exchange Administrator.  You can think of different recipient containers as different 
ways to view the recipients in an organization.  A single mailbox object, for example, can be viewed in 
the server recipient container on its home server, the site recipient container of its site, and the GAL. 
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There are four types of Recipient containers in Exchange Administrator, as depicted in Figure 
10-10. 
 

 
•  Global Address List The GAL is a master Recipient container for an entire Exchange 

organization.  It contains a list of every recipient configured in the organization—on all sites and 
on all servers. Note that some recipients are hidden; users cannot see them but they are still there.  
This is the default behavior for public folders, and this default can be configured for other types 
of recipients.  

 
•  Site Recipient Containers Site Recipient containers allow you to group recipients that belong to 

a specific site.  When you create a new Exchange organization with the first server installation, 
you see only one site Recipient container, named Recipients.  Although the Recipients container 
cannot be deleted, it can be renamed and will remain the default container for new users.  All new 
recipients created in the site are visible in this container.  You can, however, create new recipient 
containers and subcontainers at the site level.  You will learn about this process later in the 
chapter.  

 
•  Server Recipient containers Each Exchange Server that has a Private Information Store has one 

recipient container, called Server Recipients.  All mailboxes that reside on that server have 
corresponding recipient objects that can be viewed in this container.  Other types of recipients are 
not represented in server recipient containers.  

 

 
 
Figure 10-10.  Viewing recipients in the Recipients container 
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•  Public folder containers Public folder containers are specialized Recipient containers used only 
to view the public folders in your organization.  

 
NOTE:  You probably won't see any public folders in the Recipients container when you first open it 
because, by default, public folders are hidden from the address book when they are created.  You can 
choose Hidden Objects from the View menu of Administrator to make hidden recipients visible.  
 
The only type of Recipient container that you can actually create or modify is the site Recipient container.  
You can create a new Recipient container for the site or create a subcontainer for an existing site 
container. 

 
To create a new Recipient container for a site, choose New Other, and then select Recipients Container 
from the File menu of Exchange Administrator.  You will be prompted for the location where you want to 
create the new Recipient container.  This command opens property sheets for the new container, as shown 
in Figure 10-11 and then click OK.  You can modify a container's properties later by opening its property 
sheets.  Remember that after you create the new Recipient container, the only thing you'll be able to 
change is the display name. 
 
NOTE:  Keep in mind that after you create a Recipient in a Recipient container, you cannot move it to 
another container without exporting the mailbox and then importing it into the new container.  For this 
reason, it is important that you carefully plan your containers before creating your recipients.  Having 
multiple containers can be quite useful.  For example, you might choose to create all custom recipients for 
Internet users in a container separate from the main Recipients container.  Two tools that are used to 
move mailboxes around the Exchange organization are the Mailbox Migration tool and the Move Mailbox 
option.  The Mailbox Migration tool is used to move a mailbox between sites.  The Move Mailbox option 
is used for moving a mailbox between servers within the same site.  To use the Move Mailbox option, 
simply go to the Advanced tab for the mailbox and select a different server in the site.  
 
10.9.4  USING MAILBOXES 
 
Mailboxes—the mainstays of any messaging system—are private, server-based storage areas in which 
user e-mail is kept.  Every user in your organization must have access to a mailbox to send and receive 

 
Figure 10-11.  Creating a new Recipients 
container 
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messages.  Most enterprises require the ability for all associates to be able to participate in sending and 
receiving e-mail, because it is one of their primary communication methods.  One of your principal tasks 
as an administrator is to create and configure mailboxes for users. 
 
Many administrators manage the network server tasks as well as the messaging system tasks.  In an 
Exchange system, the administrator might be placed in charge of creating the Windows NT new user 
accounts and the mailboxes for Exchange Server.  Exchange Server's tools integrate these two tasks into a 
single automated function. 
 
10.9.4.1  CREATING MAILBOXES 
 
There are several ways to create mailboxes for Exchange users.  You can create a mailbox by using 
Windows NT's User Manager for Domains.  Alternatively, you can create a mailbox with Exchange 
Administrator.  You can also create mailboxes by importing user account information from a Windows 
NT Server or Novell NetWare server using the migration tools provided with Exchange, such as the 
Exchange Migration Wizard. 
 
10.9.4.2  CREATING MAILBOXES WITH USER MANAGER FOR DOMAINS 
 
When Exchange Server 5.5 is installed, several extensions for the User Manager For Domains program 
are installed as well.  The most important extension added (in the form of a file named MAILUMX.DLL) 
is one that allows you to create a new mailbox at the same time that you create a new user account.  To 
see this new extension in action, choose New User from the User menu of User Manager For Domains.  
This command displays the New User dialog box, shown in Figure 10-12. 
. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you have worked with Windows NT, you are probably familiar with this dialog box. Here's what's new, 
though. After you fill in the new user account information and click Add, User Manager For Domains 
automatically displays the property sheets for the new mailbox, as shown in Figure 10-13.  These 
property sheets enable you to immediately associate a new mailbox with the user account.  After you 
complete the information for the new mailbox, click the OK button.  The mailbox is created, and you are 
given the chance to create more new user accounts in User Manager For Domains. 

 
 
Figure 10-12.  Creating a new user account with User 
Manager for Domains 
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Figure 10-13.  Associating a mailbox with a new  
user account 
 
NOTE:  Remember that a user account with domain or account administrator privileges in NT is not 
necessarily granted administrator privileges in Exchange Server.  It is also true that a user account can 
have administrator privileges in Exchange but not in Windows NT Server.  Any Windows NT domain or 
account administrator can create a new user account by using User Manager For Domains.  To use the 
new User Manager For Domains extension provided by Exchange to create a new mailbox, that 
administrator must also have the rights of the Permissions Admin role in the Exchange Server 
organization; custom rights at the Site level or even the Recipients container level that allow mailbox 
creation. 
 
10.9.4.3  CREATING MAILBOXES WITH EXCHANGE ADMINISTRATOR 
 
Not only can mailboxes be created through User Manager For Domains, but also using Exchange 
Administrator can create mailboxes.  The process is similar to creating mailboxes with User Manager For 
Domains, but in reverse.  To create a mailbox within Administrator, choose New Mailbox from the File 
menu.  This command opens a blank set of mailbox property sheets like the one shown in Figure 10-14. 
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After you fill in the new mailbox information, click Primary Windows NT Account.  The dialog box 
shown in Figure 10-15 as it appears.  In this dialog box, you have the choice of associating this new 
mailbox with an existing Windows NT user account or creating a new user account. 
 
If you choose the option to use an existing Windows NT user account, you are shown the list of domain 
users with a suggested user account.  Exchange looks for a user account with the same or similar name 
and suggests the closest approximation to the mailbox you created.  The domain selected will be the one 
in which your Exchange Server participates. 
 

                                         
 
                                                  Figure 10-15.  Associating a user account with a 
                                                  new mailbox 
 

                                                        
 
                                               Figure 10-16.  Creating a new Windows NT user account 

 
 
Figure 10-14.  Creating a mailbox in Exchange 
Administrator 
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If you choose to create a new Windows NT account with which to associate the new mailbox, the Create 
Windows NT Account dialog box opens (Figure 10-16).  In this dialog box, you can select the domain 
and account name for the new account.  The domain suggested in this dialog box is the one to which 
Exchange Administrator is currently connected or the default domain set within Administrator.  The 
suggested user account name is the alias name of the new mailbox. 
 
CAUTION:  Although you can create a new user account when you create a mailbox in Exchange 
Administrator, doing so as a general practice is not recommended.  The new user account is created with a 
name only—not with a password.  Although the administrator is warned of this situation and the user is 
required to supply a password at first logon, creating a new user account from Exchange Administrator is 
not a secure way of managing accounts.  You still have to go to User Manager For Domains to configure 
information about the new account. 

 
10.9.4.4  CREATING MAILBOXES WITH DIRECTORY IMPORT 
 
Being able to create individual accounts with User Manager For Domains or Exchange Administrator is 
great.  Many enterprises that implement Exchange already have an existing network operating system 
with user accounts completely configured.  If you already have all your user accounts set up on your 
network, can't you create new mailboxes for all of them at the same time? In a word, yes. 
 
You can quickly create groups of mailboxes based on Windows NT or LAN Manager user account lists, 
NetWare account lists, or other Exchange Server account lists.  The process is simple: 
 

1. Extract the user information from its source. 
 
2. Import that extracted information into Exchange Server, creating the new mailboxes. 

 
Extracting User Information No matter how you choose to extract user account information or where 
you extract it from, this information should always be extracted to a comma-separated values (.CSV) file, 
which can then be imported into Exchange Server.  However, you must use different tools to extract the 
information from different sources.  To extract Windows NT, LAN Manager, NetWare, and Exchange 
Server account lists, you can use tools in Exchange Administrator. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Extracting Windows NT Account Lists To extract account lists from Windows NT or LAN Manager, 
choose Extract Windows NT Account List from the Tools menu of Exchange Administrator.  This 

 
Figure 10-17.  Extracting Windows 
NT user accounts from a domain 
controller 
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command opens the Windows NT User Extraction dialog box, shown in Figure 10-17.  You must provide 
the domain from which to extract the account list and the name of a primary or backup domain controller 
(PDC or BDC) in that domain.  You must also specify the name of the .CSV file to which the information 
should be extracted.  This extraction works the same way whether you name a Windows NT Server or a 
LAN Manager server. 
 
When you click OK, extraction begins.  Even in domains that have many users, this process should go 
fairly quickly.  In fact, extractions for several thousand users can take mere minutes. 
 
Extracting NetWare Account Lists Extracting account information from a NetWare server is just as easy 
as extracting it from a Windows NT Server.  You can extract user accounts from NetWare 2.x, 3.x, 4.x, or 
5.x.  If you are using NetWare 4.x or NetWare 5.x, the NetWare server must be running bindery 
emulation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To begin the extraction, choose Extract NetWare Account List from the Tools menu of Exchange 
Administrator.  This command opens the NetWare User Extraction dialog box, shown in  
Figure 10-18. 
 
You must provide the name of a NetWare server as well as the name and password of a user account with 
Supervisor privileges on that server.  Notice that the dialog box has no convenient drop-down menu or 
Browse button; you must type this information.  As you do in a Windows NT extraction, you also need to 
designate a .CSV file to receive the extracted information. 
 
NOTE:  Whether you extract user lists from Windows NT or NetWare, the format of the resulting .CSV 
file is the same.  Five fields are populated with data from the extraction:  
 
•  Obj-Class Type of object being extracted 

 
•  Common-Name User name 

 
•  Display-Name Name displayed for the user 

 
•  Home-Server Name of the home server  
 

 
 
Figure 10-18.  Extracting user accounts 
from a NetWare server



Air Force Workgroup Management Course – Module 10 
 

 

 
1 January 2003 

27 

Nomma delimiter lets the value of each field vary.  For example, the Display Name field can be John Doe 
or John Dodenhoff, and the comma delimiter ensures that the names are not cut off at the wrong places.  
Additionally, if commas will be in the data itself—for example "Doe, John"—the data field will need to 
be embedded in quotes. 
 
Extracting Exchange Server Directories You can extract recipient information from an existing Exchange 
Server.  This technique can be useful if you want to export Exchange recipients for use on another 
messaging system or to back up your recipient list, in case you ever need to rebuild or upgrade your 
Exchange Server. 
 
To export your Exchange Directory, choose Directory Export from the Tools menu of Exchange 
Administrator.  This command opens the Directory Export dialog box, shown in Figure 10-19. 

 
NOTE  Exporting an Exchange Server Directory to a .CSV file is a useful way to create a printable list of 
the recipient information for your organization in addition to its ability to create mailboxes en masse.  
Comma-separated value files are a standard file format for many programs and are used to move data 
between some programs that are otherwise incompatible.  The Exchange-created .CSV file can be 
imported into many other types of applications, such as Microsoft Excel or a database program, and used 
for other purposes. 
 
The first thing to notice is that you get more control of what information is exported than you do when 
you extract user lists from Windows NT or NetWare.  You can configure the following parameters in this 
dialog box: 
 

•  MS Exchange Server This field represents the name of the Exchange Server that will actually 
perform the export of recipient information.  The default selection is the server to which you are 
currently connected, but the drop-down menu provides a list all Exchange Servers on the site. 

 
•  Home server The home server is the server in the site that contains the recipient information you 

want to export.  All is selected by default, meaning that recipient information will be exported 
from all servers in the site. 

 

 
 
Figure 10-19.  Exporting Exchange Directory 
information 
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•  Export file This field specifies the name of the .CSV file to which the exported information 
should be saved. 

 
•  Container This field specifies the container from which information should be exported.  The 

default choice is the Recipients container, which exists on all servers. 
 
•  Include subcontainers When this option is selected, any containers within the specified 

container are also exported. 
 
•  Export objects You can designate which types of recipient objects should be included in the 

export.  You can choose from among all available types of recipients except public folders. 
 
•  Logging level Use this option to specify whether a log of the export should be created and 

whether that log should have low or high detail. 
 
•  Separators Use this button to specify what character should be used to separate the values in 

your export file.  By default, this option is set to use a comma. 
 
•  Character set You can choose to use either ANSI or Unicode as the character set for your 

exported file.  This choice largely depends on the system to which you will import the 
information. 

 
•  Include hidden objects Recipients can be hidden from the Global Address book so that users do 

not have direct access to them.  Select this option if you want to include hidden objects in the 
export. 

 

 

                                      
                                                   Figure 10-20.   Importing Directory Information 
                                                   into Exchange Server 

 
NOTE: You can also extract information from other sources, such as employee databases.  All you have 
to do is make sure that you save the information to a .CSV file in a format that an Exchange Server can 
use for an import.  If you need more information on this procedure, consult your product documentation. 
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Importing Directories into Exchange Server No matter how you create the .CSV file for importing 
users, the import procedure is the same.  To begin an import, choose Directory Import from the Tools 
menu of Exchange Administrator.  This command opens the Directory Import dialog box, shown in 
Figure 10-20. 
 
As you can see, this dialog box is quite similar to the Directory Export dialog box (refer to  
Figure 10-19).  You can configure the following in this dialog box: 
 

•  Windows NT domain Use this menu to choose the domain in which Windows NT user accounts 
should be created if you choose to create user accounts along with the new mailboxes.  That 
selection is made in the Account Creation section of the dialog box. 

 
•  MS Exchange Server Use this menu to select the Exchange Server in the site on which the new 

mailboxes will be created. 
 
•  Container Designate the container in which the new mailboxes will be placed.  You can also 

specify whether to use the indicated container or containers specified in the import file. 
 
•  Recipient template Use this option to specify a recipient template to use when importing 

recipients.  A template is a recipient object that you create to serve as a model for the new 
recipients to be created during the import.  Information configured for the template is included 
automatically in newly created recipients.  Templates, which can be very useful for ensuring that 
mailboxes are consistent, are discussed later in this chapter.)  

 
•  Import file Designate the .CSV file from which to import user accounts. 
 
•  Account creation Use this section to specify whether to create new Windows NT user accounts 

at the same time new mailboxes are created.  If you choose to do so, accounts will be created in 
the domain specified in the Windows NT Domain field.  If you choose to create new user 
accounts, you can also specify that a random password be assigned to each new account.  Finally, 
you can specify that mailboxes deleted during the import have their associated Windows NT 
accounts deleted as well.  You should create new user accounts only after conferring with your 
local Windows NT administrator. 

 
•  Logging level Specify whether a log should be created during the import process.  This log 

contains details about the process for later review. 
 
•  Separators If your import file uses a character other than a comma to separate values, you can 

specify that character. 
 
•  Multivalued properties Some properties of recipients can have multiple values.  Use this option 

to specify whether existing values of such properties are overwritten or appended.  An example of 
a multivalued property is the e-mail addresses of a mailbox.  Each mailbox can have multiple e-
mail addresses associated with it, such as X.400, SMTP, and MS Mail. 
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10.9.5  CONFIGURING MAILBOX PROPERTIES 
 
No matter which method you use to create mailboxes, you configure them the same way—by using the 
new mailbox object's property sheets.  If you create a mailbox by using User Manager For Domains or 
Exchange Administrator, you can access all these property sheets at the time of creation.  If you create 
mailboxes by importing directory listings, you can access the property sheets only after the mailboxes 
have been created.  To do so, select any mailbox in Exchange Administrator and then choose Properties 
from the File menu.  This section covers the property sheets in detail. 
 
 
10.9.5.1  GENERAL PROPERTY SHEET 
 

                                     
 
                                                 Figure 10-21.  Assigning user information 
                                                 on the General property sheet 
 
The General property sheet, shown in Figure 10-21, is where you configure basic user information.  The 
first name, middle initial, and last name that you enter are used to generate a display name and alias name, 
according to the Auto Naming rules that you set up in Exchange Administrator.  The display name is the 
name of the recipient as it appears in the Exchange Administrator window.  The alias name can be used as 
an alternate means of addressing the recipient in messages.  You can use the Primary Windows NT 
Account button to change the NT user account with which the mailbox is associated.  The rest of the 
information on this property sheet is used to further identify the recipient.  All this information, save for 
the Windows NT account information, is available to users when they browse the Global Address List. 
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10.9.5.2  ORGANIZATION PROPERTY SHEET 
 

                                 
 
                                                Figure 10-22.  Describing a user’s  
                                                position in the organization by using  
                                                the Organization property sheet 
 
The Organization property sheet, shown in Figure 10-22, is used to configure additional information 
about the user's position in the company.  You can use this sheet to specify a user's manager and a list of 
people who report directly to the user.  Click either Modify button to display a list of recipients in the 
organization.  All the information configured on this property sheet is also available in the Global 
Address List. 
 
10.9.5.3  PHONE/NOTES PROPERTY SHEET 
 
The Phone/Notes property sheet, shown in Figure 10-23, lets you configure additional information for a 
user.  It also has a place for you to enter notes about the user.  The information on this sheet is available in 
the Global Address List. 
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                                                    Figure 10-23.  Configuring Additional 
                                                    Information on the Phone/Notes Property Sheet 
 
10.9.5.4  DISTRIBUTION LIST PROPERTY SHEETS 
 
The Distribution Lists property sheet, shown in Figure 10-24, lists the distribution lists to which the 
mailbox currently belongs.  You can add or remove distribution lists by clicking the Modify button and 
then making choices from available lists.  Not only can you manage a distribution list from a mailbox's 
properties, but also you can manage a distribution list from the distribution list's properties. 
 

                                               
 
                                                 Figure 10-24.  Viewing e-mail addresses for a mailbox 
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10.9.5.5 E-MAIL ADDRESSES PROPERTY SHEET 
 

                                        
 
                                                    Figure 10-25.  Viewing the distribution  
                                                    lists to which a mailbox belongs 
 
The E-mail Addresses property sheet, shown in Figure 10-25, lets you configure how the mailbox is 
addressed from different types of messaging systems. 
 
When you create a mailbox, four types of addresses are configured automatically by default: 
cc:Mail, MS Mail, SMTP, and X.400.  You can add, remove, or edit addresses as you please.  A 
mailbox can have multiple addresses for a single type.  For example, a mailbox for the Web site 
administrator, Jane Doe, may have jdoe@company.com and webmaster@company.com as two 
SMTP addresses.  These two addresses will send mail to the same mailbox. 
 
NOTE You can change addresses manually for each mailbox.  You can also change addressing 
configuration of the address spaces at the site using the Site Addressing object and have those 
changes flow down to individual mailboxes 
 
10.9.5.6  DELIVERY RESTRICTIONS PROPERTY SHEET 
 
The Delivery Restrictions property sheet, shown in Figure 10-26, allows you to restrict messages coming 
into the selected mailbox.  By default, all messages are accepted and no messages are rejected.  
Acceptance and rejection lists are maintained individually.  You can specify that messages be accepted 
only from designated senders and that messages from certain senders be rejected.  Click the Modify 
button below either the Accept or Reject list to add users from the Global Address List.  You can add any 
recipients listed in the organization's directory.  
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                                                          Figure 10-26.  Designating which recipients 
                                                          can and cannot send mail to a mailbox 
 
10.9.5.7  DELIVERY OPTIONS PROPERTY SHEET 
 
The Delivery Options property sheet, shown in Figure 10-27, allows you to assign certain types of 
access—called delegate access—to the mailbox to Exchange users other than the primary user. 
 
The first type of delegate access is called Send On Behalf Of permission.  You can grant this permission 
to any recipient in the Exchange Directory by clicking the Modify button below the Give Send On Behalf 
Of Permission To list.  Users included in this list can send messages as though those messages came from 
the selected mailbox.  Any messages sent include the names of both the primary mailbox user and the 
user who actually sent the message.  An assistant who needs to send a message from a manager who is 
out of the office might use this permission. 
 
NOTE Send On Behalf Of permission can also be helpful in troubleshooting.  If you assign yourself, as 
administrator, this permission, you can send test messages from any recipient in the organization.  This 
practice can be a great way of testing connections from remote servers.  We recommend that you use test 
mailboxes created for this purpose and not actual user mailboxes.  Many users would consider having 
extended access into their e-mail an intrusion. 
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                                       Figure 10-27.  Assigning delegate access to a mailbox 
 
The other thing that you can do on the Delivery Options property sheet is assign an alternate recipient for 
a mailbox.  Any messages sent to the mailbox are routed to the mailbox of the designated alternate 
recipient.  As a further option, you can specify that messages be sent both to the primary mailbox and to 
the alternate recipient.  Exchange will deliver a separate reference to the message to all mailboxes listed 
on this page, so deleting the message from one mailbox does not cause it to be deleted from another 
mailbox. 
 
Users have the capability of assigning the Send On Behalf Of permission for their own mailboxes from 
within Outlook.  Users also have the ability to specify an alternate recipient from within Outlook.. 
 
Another type of delegate access in Exchange is called Send As permission.  This permission is a powerful 
form of delegate access that can be assigned only by an administrator. 
 
10.9.5.8  PROTOCOLS PROPERTY SHEET 

                                   
                                          Figure 10-28.  Configuring Internet Protocols for a Mailbox 
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The Protocols property sheet, shown in Figure 10-28, allows you to enable or disable individual Internet 
protocols for the selected mailbox.  The columns show whether each protocol is enabled for the selected 
mailbox, whether the protocol is enabled for the server on which the mailbox is located, and how settings 
are applied for the protocol.  The protocols that you can configure include HTTP (Web), IMAP4 (Mail), 
NNTP (News), and POP3 (Mail).The LDAP (Directory) protocol is included in this list, but it cannot be 
configured at the level of the individual mailbox.  It is included on this property sheet so that you can 
easily determine whether it is enabled on the server to which the selected mailbox belongs. 
 
10.9.5.9  CUSTOM ATTRIBUTES PROPERTY SHEET 
 

                                      
 
                                                 Figure 10-29.  Entering additional recipient 
                                                 information by using Custom Attribute fields 
 
The Custom Attributes property sheet, shown in Figure 10-29, lets you enter information about a mailbox 
in 10 custom fields.  These fields can be used for any information that you need to include that isn't 
available on the other property sheets.  All of these fields are available to users in the Global Address 
List.  By default, these fields are labeled Custom Attribute 1 through Custom Attribute 10, but they can be 
customized to suit your needs. 
 
10.9.5.10  LIMITS PROPERTY SHEET 
 
The Limits property sheet, shown in Figure 10-30 lets you assign limits on how the selected mailbox 
handles messages.  These limits are discussed in the following sections. 
 
Exchange Server 5.5 includes a new feature that gives users a certain amount of time to recover items that 
have been deleted from their Deleted Items folder.  When a user deletes the item from the Deleted Items 
folder, it is then actually deleted from the user's personal folders.  However, the deleted item is not 
actually deleted from the Exchange Information Store.  Instead, the message is marked as hidden and is 
kept for a specified amount of time.  During that period, the user can use the client application to recover 
the item.  Note that the ability to recover deleted items requires using Outlook 8.03 or later. 
 
A default retention time is configured for the Information Store of each Exchange site.  You can use this 
default value or override it with a different value for the selected mailbox.  If you choose to override the 
value, you can also specify that deleted messages not be permanently removed until the Information Store 
has been backed up. 
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                                               Figure 10-30.  Setting limits on mailbox size, attachments, 
                                               retention, etc.  Deleted Item Retention Time 
 

 
Information Store Storage Limits Often, users send and save huge attachments or are just negligent 
about cleaning out their mailboxes.  Both of these situations can consume a great deal of disk space on 
your server.  Fortunately, administrators can set any of three storage limits on a mailbox: 
 

•  Issue warning This limit specifies a size, in kilobytes, that a mailbox can reach before a warning 
is issued to the user to clean out the mailbox.  

 
•  Prohibit send This limit specifies a size, in kilobytes, that a mailbox can reach before the user is 

prohibited from sending any new mail.  This prohibition ends as soon as the user clears enough 
space to fall back within the limit. 

 
•  Prohibit send and receive This limit specifies a size, in kilobytes, that a mailbox can reach 

before the user is prohibited from sending, receiving, or even editing any mail.  The only action 
that a user can take is deleting messages.  This prohibition ends as soon as the user clears enough 
space to fall back within the limit.  To clear enough space, a user must delete items from his or 
her mailbox and then empty the Deleted Items folder.  When a user sends a message to a recipient 
who is prohibited from receiving any new messages, a nondelivery report is generated and 
returned to the sending user.  Prohibiting the sending and receiving of mail is a pretty strong 
measure for an administrator to take.  We recommend that you implement this solution only if 
you experience continued problems that you cannot otherwise resolve.  

 
Message Sizes The last type of limit that you can configure on the Limits property sheet involves 
message sizes (refer back to Figure 10-30).  You can set a limit on the size of messages that can be 
transferred out of or into a particular mailbox.  Limits on outgoing and incoming messages are set 
individually.  If a message exceeds the limit, the message is not sent or received, and the sender of the 
message receives a nondelivery report. 
NOTE   Setting general storage limits for an entire site or server at the same time is much more efficient 
than setting them for each individual user.  Setting limits for a particular mailbox is one way of dealing 
with users who need to send large messages or users who simply let the junk accumulate.  
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10.9.5.11  ADVANCED PROPERTY SHEET 
 

                                        
 
                                                    Figure 10-31.  Configuring advanced  
                                                    mailbox options  
 
You can use the Advanced property sheet, shown in Figure 10-31, to configure all the options that the 
Exchange team at Microsoft decided didn't fit on other property sheets. 
 
The parameters that you can configure on the Advanced property sheet include the following: 
 

•  Simple display name The simple display name is an alternate name for the mailbox.  It appears 
when, for some reason, the full display name cannot.  This situation often occurs when multiple 
language versions of Exchange Administrator are used on the same network. 

 
•  Directory name The directory name is the name of the mailbox object as it appears in the 

Exchange Directory Information Tree (DIT).  You can change this name only while creating the 
mailbox.  After a mailbox has been created, this option is no longer available.  

 
•  Trust level The trust level determines whether a recipient is included when directories are 

synchronized between Exchange and a foreign messaging system.  Trust levels range from 0 to 
100 and are set for both recipients and directory synchronization requestors.  If a recipient's trust 
level is equal to or less than the trust level of the requestor, the recipient is synchronized. 

 
•  Home server This setting specifies the server on which the current mailbox is stored.  Selecting a 

different server is one way of moving a mailbox between servers.  Other ways to move mailboxes 
are discussed later in this chapter. 

 
•  Online listings information If you use Microsoft NetMeeting in your organization, this option is 

for you.  NetMeeting allows users to collaborate on documents by using audio, video, and a 
shared whiteboard.  Use the ILS Server and Account fields to set up your Internet Locator Service 
(ILS).  When this information is configured, users can contact and set up meetings with the user 
of this mailbox.  For more information on using NetMeeting in your organization, see The 
Official Microsoft NetMeeting Book (1998) by Bob Summers from Microsoft Press.  
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•  Hide from address book By default, all recipients except public folders are visible to users via 
the Global Address List.  You can use this option to hide a mailbox from that list.  The mailbox 
will still be able to receive mail; it just will not be included in Address Book Views. 

 
•  Outlook Web Access (OWA) server name Typically, the OWA server for an Information Store 

is set at the server level, and all recipients configured on that Exchange Server use the server-
level settings.  You can, however, designate a different OWA server for an individual mailbox.  

 
•  Container name Multiple Recipient containers can be created on a single server.  When you 

create a mailbox, you can specify the Recipient container in which it will be stored.  After the 
mailbox has been created, this option is no longer available.  

 
•  Downgrade high-priority X.400 mail If this option is selected, the current mailbox cannot send 

high-priority messages to X.400 systems.  If a high-priority message is sent, it will be 
downgraded to normal priority automatically.  

 
•  Administrative note An administrative note is a convenient place for you to enter free-form 

text about a mailbox.  This note is visible only on this property sheet.  Most objects in Exchange 
Server allow you to make administrative notes.  

 
10.9.6  CLEANING MAILBOXES 
 
The best way to govern the size of user mailboxes is to set general Information  Store storage limits at the 
site and server levels and to occasionally set limits at the mailbox level, as necessary.  Sometimes, 
however, this is not feasible.  You may not want to set strong limits, or the mailbox may grow out of hand 
before you have the chance to set limits.  In such a case, you have another option:  You can clean the 
mailbox yourself. 
 
You clean a mailbox by selecting the mailbox in Exchange Administrator and then choosing  Clean 
Mailbox from the Tools menu.  This command displays the dialog box shown in Figure 10-32.  This 
dialog box allows you to enter various criteria governing messages that you want to remove from the 
mailbox.  After you select the types of messages that you want to remove, you can choose to delete them 
immediately or move them to the Deleted Items folder. 
 
You should use the Clean Mailbox tool only as a last resort.  Limits and kind messages to users are more 
effective in the long run.  Keep in mind that a user's mailbox is a private area.  If you invade that private 
area, you run the risk of alienating users by causing them to lose trust in your messaging system. 
 
All these limits can be set for an entire site or server as well.  Settings made at the mailbox level override 
any settings made at the site or server level. 



Air Force Workgroup Management Course – Module 10 
 

 

1 January 2003 

40 

                                    
 
                                               Figure 10-32.  The Clean Mailbox dialog box 
 
10.9.7  MOVING MAILBOXES 
 
You might want to move a mailbox to a different server for any of several reasons.  Perhaps you want to 
balance the load by splitting up an increasing number of mailboxes on one server and moving them to 
different servers.  Or you might have just installed a powerful new server and want to consolidate 
mailboxes located on disparate servers. 
 
Whatever your reason for moving a mailbox, Exchange Administrator provides two convenient ways for 
you to do so.  There is one catch, however, you can use these simple techniques only to move mailboxes 
between servers in the same site.  These techniques do not allow you to move mailboxes to different 
containers on the same server or between servers in different sites. 
 
NOTE   If you want to move recipients between servers in different sites or to a new Recipient container, 
use the Directory Import and Export features discussed earlier in this chapter.  
 

 
 

Figure 10-33.  Moving mailboxes between servers on a site 
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The first way to move a mailbox to a different server in the same site is a way that you saw earlier in this 
chapter.  On a mailbox object's Advanced property sheet is a configuration item called Home Server 
(refer to Figure 10-33).  If you choose a different server from this drop-down list, the mailbox is moved to 
that server. 
 
The second way to move mailboxes between servers on a site is even easier and allows you to move many 
mailboxes at the same time.  In Exchange Administrator, select the mailboxes that you want to move from 
the Global Address List or a Recipient container.  Then choose Move Mailbox from the Tools menu to 
open the Move Mailbox dialog box, shown in Figure 10-33.  Use this dialog box to find the server to 
which you want to move the mailboxes. 
 
NOTE The Move Mailbox command moves large groups of mailboxes at the same time and fairly 
quickly.  You can also use this command to move mailboxes even if those mailboxes' users are currently 
online.  If you recall, Exchange uses single-instance storage during normal operations to ensure that only 
one copy of a particular message ever needs to be stored in the Information Store.  Pointers to that 
message are placed in recipients' mailboxes if that message is sent to multiple recipients.  This means that 
a 1MB message sent to 50 recipients consumes only 1MB of disk space in the Information Store.  If a 
message is not available on the server to whom a mailbox is being moved, the message is moved along 
with the mailbox.  For this reason, the amount of space required for individual mailboxes on the new 
server may be larger than that required on the previous server. 
 
10.9.8  USING CUSTOM RECIPIENTS 
 
Custom recipients are objects that serve as pointers to resources outside an Exchange organization.  You 
can think of a custom recipient as an alias that contains an address for that outside resource and rules for 
handling the transmission of messages.  Whenever a user sends a message to a custom recipient, the 
message is forwarded to the appropriate foreign messaging system.  Custom recipients have many of the 
same attributes as mailboxes and can be viewed in the GAL or site Recipient containers. 
 
10.9.8.1  CREATING CUSTOM RECIPIENTS 
 
Custom recipients can be created only with Exchange Administrator.  To create a custom recipient, 
choose New Custom Recipient from the File menu.  This command opens the New E-Mail Address 
dialog box, shown in Figure 10-37.  You must select the type of foreign system on which the custom 
recipient resides, which helps construct an address space that will be used in routing messages to the 
appropriate external gateway.  When you finish, click OK. 
 

                                              
 
                                                            Figure 10-34.  Selecting an e-mail address  
                                                            type for a new custom recipient 
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After you choose the appropriate address type, you are asked to enter the actual e-mail address of the 
recipient, as shown in Figure 10-35.  Enter this address according to the specific format of the address 
type that you've chosen.  After you make this entry and click OK, the custom recipient is created.  If an 
appropriate gateway to the foreign system has been configured, users can send messages to the new 
custom recipient immediately.  
 
10.9.8.2  CONFIGURING CUSTOM RECIPIENTS’ PROPERTIES 
 

                                          
 
                                                     Figure 10-35.  Entering an e-mail  
                                                     address for a new custom recipient 
 
Just like all other objects in Exchange, custom recipients are configured by means of property sheets.  The 
property sheets are displayed immediately after you create a custom recipient and can be opened any time 
thereafter in the normal manner.  Most of the property sheets for custom recipient objects are identical to 
those for mailbox objects.  The biggest difference is that the custom recipient has no Delivery Options or 
Limits property sheet. Of the remaining property sheets, only two differ in any way:  General and 
Advanced.  For that reason, only those two sheets are covered in this section.  For details on any of the 
other sheets, refer to the section of this chapter on configuring mailboxes. 
 
10.9.8.2.1  GENERAL PROPERTY SHEET 
 
The custom recipient's General property sheet, differs from the mailbox General property sheet in only 
one way.  Instead of a Primary Windows NT Account field, it has an e-mail field.  This field contains the 
full e-mail address of the recipient, including the e-mail address type (SMTP) and the user's address on 
the foreign system.  You can change this address by clicking on E-mail. 
 
10.9.8.2.2  ADVANCED PROPERTY SHEET 
 
The custom recipient's Advanced property sheet, is different from its mailbox counterpart in several ways: 
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•  There is no Home Server field. Instead, you can designate the Recipient container in which the 
custom recipient object resides.  

 
•  You can configure the maximum size of messages that can be sent to the custom recipient. This  

option is located on the Limits property sheet for mailboxes. 
 
•  You can choose whether to allow rich-text format (RTF) messages to be sent to the custom 

recipient.  Many foreign messaging systems do not support this format.  
 
•  You can associate a primary Windows NT account with the custom recipient.  The Windows NT 

account designated on this property sheet will act as a manager for the custom recipient.  This 
manager can then use the custom recipient to send messages.  This association provides much the 
same benefit as the Send As permission.  

 
•  There is no X.400 option.  
 
•  You cannot assign an Outlook Web server.  
 

10.9.9  USING DISTRIBUTION LISTS 
 
A distribution list is a special kind of recipient object that is used to reference multiple other recipients.  A 
distribution list can contain any other type of recipient—even other distribution lists.  When a message is 
sent to the distribution list, the list is expanded, and the message is sent to each member of the list 
individually.  Distribution lists can be viewed in the GAL and in site Recipient containers. 
 
 
 
 

   
 
Figure 10-36.  Viewing General properties of   Figure 10-37.  Viewing advanced properties for a  
custom recipient      a custom recipient 
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10.9.9.1  CREATING DISTRIBUTION LISTS 
 
Creating a new distribution list, which you can do only from Exchange Administrator, is easy. Choose 
New Distribution List from the File menu.  This command opens the property sheets for the new 
distribution list, as shown in Figure 10-38. 
 
Your first task in creating the distribution list is naming it.  You need to provide a display name, which 
shows up in the GAL, and an alias name, which can be used to address messages to the list.  In large 
organizations, the names of distribution lists should be thought out carefully.  A large GAL will be the 
best camouflage for a distribution list if it does not have a name that users can identify easily.  The use of 
alias names was covered earlier in this chapter in the discussion of mailboxes. 
 

                               
 
                                                      Figure 10- 38.  Creating a distribution list 
 
The next thing that you need to do is specify an owner for the list.  The owner of a list is given permission 
to modify the list's membership.  By default, the administrator who creates the list is the owner, but you 
can designate as owner any mailbox, distribution list, or custom recipient in the GAL.  If you give 
ownership to another user, that user can use an Exchange client or Outlook to modify the list's 
membership and does not need access to Exchange Administrator.  You can relieve yourself of a great 
deal of work by specifying owners for distribution lists.  As distribution lists grow larger, they can 
consume a considerable amount of management time. 
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                                                                   Figure 10-39.  Adding members to a  
                                                                   distribution list 
 
Your next step is adding members to the list. To do so, click the Modify button below the Members list 
box.  This button opens a view of the GAL that allows you to select recipients—whether custom 
recipients, mailboxes, or other distribution lists—to include, as shown in Figure 10-39.  After you choose 
the list members, click OK to add them to the distribution list. 
 
The final thing that you may want to do when you create a list is designate a specific expansion server.  
Remember that whenever a message is sent to a list, the list must be expanded so that the message can be 
sent to each member of the list.  The Message Transfer Agent Service of a single Exchange Server 
performs this expansion.  The default choice is Any Server In Site (Figure 10-40).  This choice means that 
the home server of the user sending the message always expands the list.  You can also designate a 
specific server in the site to handle expanding the list.  The choice of a dedicated expansion server is a 
good one if you have a large distribution list.  In this case, expansion could consume a great amount of 
server resources, which can compromise performance for busy servers.  Often, sites have dedicated 
expansion servers. 
 
When you finish, click OK to create the list.  The new distribution list should be available for use almost 
immediately. 
 
10.9.9.2  USING DELIVERY RESTRICTIONS ON DISTRIBUTION LISTS  
 
Even though the Delivery Restrictions property sheet for distribution lists is identical to the Delivery 
Restrictions property sheet for mailboxes, delivery restrictions are often much more useful for distribution 
lists.  In large organizations, DLs can grow quite large, sometimes holding thousands of users.  Because 
of the possibility of misuse, it is not usually a good idea to provide general access to DLs this large.  
Imagine the increase in traffic if your users send messages to thousands of users every time their kids sell 
candy bars or every time they find a particularly good joke.  Placing delivery restrictions on large DLs 
allows you to limit access to the lists to a few select, responsible users. 
 
Another potential risk is that somebody from the Internet could e-mail your whole company using a DL's 
SMTP address.  Imagine what your job would be like the day an "anonymous" person e-mailed malicious 
information to your whole company. 
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10.9.9.3  CONFIGURING DISTRIBUTION LIST PROPERTIES 
 

                                          
 
                                                          Figure 10-40.  Viewing advanced 
                                                          properties for a distribution list 
 
You can configure other property sheets for a distribution list either when you create the list or after you 
create it.  The General property sheet was covered in the previous section on creating distribution lists.  
Most of the other property sheets are identical to the Mailbox property sheets of the same name, so refer 
to the mailbox section of this chapter for details on those property sheets.  Note that some of the property 
sheets found on a mailbox recipient simply don't exist for a distribution list.  The only property sheet that 
does differ is the Advanced property sheet, shown Figure 10-40.  This sheet holds several configuration 
items that are familiar to you, such as display name, trust level, and message limits. 
 
You can configure several options that are particular to distribution lists: 
 

•  Report to distribution list owner If you enable this option, notification is sent to the owner of 
the list whenever an error occurs during the delivery of a message to the list or to one of its 
members.  Note that this option is unavailable if the distribution list has not been assigned an 
owner.  

 
•  Report to message originator If you enable this option, error notifications are also sent to the 

user who sent a message to the list.  
 
•  Allow out-of-office messages to originator Users of Exchange clients can configure rules that 

automatically reply to messages received while the users are away from their offices.  When this 
option is enabled, users who send messages to DLs can receive those automatic out-of-office 
messages from members of the list.  For particularly large DLs, it's best not to allow out-of-office 
messages to be delivered, because of the excess network traffic they generate.  Hide from 
address book If you enable this option, the DL is not visible in the GAL. 

 
•  Hide membership from address book If you enable this option, users cannot view the 

membership of the DL by using the GAL. 
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10.9.10  USING TEMPLATES 
 
A template is a recipient object that is used as a model for creating other recipient objects of that type. 
Every recipient type except public folders can serve as a template. 
 
To create a template, create a recipient object as you normally would.  Enter any information that you 
want to use in the model.  If, for example, you are creating a mailbox template to use for new employees, 
you might enter all the organizational, phone, and address information for your company. 
 
NOTE:  When you create a recipient to use as a template, you probably will want to hide the recipient 
from the address book using the template's Advanced property sheet.  This way, users won't be able to 
view it in the GAL.  You can always choose to view hidden recipients in Exchange Administrator, so you 
will be able to see it.  You should also name your template in such a way that it is both easy to find and 
easy to distinguish from regular recipients. 
  
You can use a template in two ways.  The first way is to specify it as a recipient template during a 
directory import, which allows you to create a batch of new recipients that have common information. 
 
You can also use a template to create an individual recipient.  To do so, select the template in Exchange 
Administrator and then choose Duplicate from the File menu.  A set of property sheets for the new 
recipient object opens, including all the information in the template except for certain names (such as the 
display, alias, and directory names). 
 
10.9.11  MANAGING RECIPIENTS 
 
As your organization and the number of recipients in it grows, it can become quite time-consuming to 
scroll through lists of recipients looking for the ones you need.  Fortunately, Exchange Administrator can 
help. 
 
10.9.11.1  FILTERING RECIPIENTS 
 
The first option that you might try if you are looking for certain types of recipients is to use the View 
menu to filter the recipient objects that are displayed in Exchange Administrator.  You can use this 
technique no matter what Recipient container you are viewing at the time. You have a couple of filtering 
options: 
 

•  Filter by recipient type You can choose to view, for example, only public folders or only custom 
recipients.  Filtering your recipient view can be useful if you are looking for a specific recipient 
and the list based on recipient type is not very long or if you need to select all the recipients of a 
certain type.  You can also choose to view recipients of all types at the same time, of course.  

 
•  Specify whether to view hidden recipients This option can eliminate many entries from the 

display and is also a great way to view all recipients except public folders and other recipients 
that may be hidden.  
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10.9.11.2  FINDING RECIPIENTS 
 
Exchange Administrator provides a recipient search tool that allows for more sophisticated searching 
criteria than is available from the View menu.  You open this tool by choosing Find Recipients from the 
Tools menu.  This command opens the Find Recipients window, shown in Figure 10-41. 
 
You can use this tool to search for only one Recipient container at a time.  The default choice is the 
Recipients container for the site, but you can select another container by clicking the Container button. 
 
As you see in Figure 10-41, you can use many common attributes to search for recipients, such as the 
different names for the object and some organizational information.  By clicking Custom, you can also 
search using any of the 10 custom attributes covered earlier in this chapter. 
 
After you select your criteria, click Find Now to display the results of the search.  The results are actual 
recipient objects.  You can open these objects' property sheets or perform certain other administrative 
functions from this dialog box. 

10.9.12  USING ADDRESS BOOK VIEWS 
 
Address Book Views are a clever feature of Exchange Server that allows you to group recipients in the 
GAL according to attributes.  Essentially, Address Book Views allow you to add a hierarchical structure 
to the otherwise flat view provided by the GAL. 
 

                                                
                               Figure 10-42.  Looking at the hierarchical structure of an Address Book View 

 
 
Figure 10-41.  Finding recipients in Exchange 
Administrator 
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Figure 10-42 shows an example of an Address Book View. The view, named Location, groups recipients 
first by country, then by state, and finally by city.  The recipient, Walter J. Glenn, is in Huntsville, which 
is in AL (Alabama), which is in the United States. 
 
Address Book Views can be quite useful in large or complex organizations.  Users can open these views 
in client applications and find information on recipients quickly.  Administrators can use the views in 
Exchange Administrator to help organize recipients.  After you find a recipient in an Address Book View,  
you can manage it the same way that you manage recipients displayed in other containers: by opening its 
property sheets.  Views are updated on a 30-minute cycle. 
 
To create an Address Book View, choose New Other Address Book View from the File menu of 
Exchange Administrator.  This command opens a set of Address Book View property sheets, as shown in 
Figure 10-43. 
 

After you enter a display name and directory name, switch to the Group By property sheet, shown in 
Figure 10-44.  This property sheet allows you to define the hierarchical structure of the new view. Choose  
the top level of your hierarchy from the Group Items By drop-down list, and choose subsequent levels 
from the Then By drop-down lists.  The attributes by which you can group recipients are as follows: city, 
company, country, any of the custom attributes that you have defined, department, home server, site, 
state, and title. 

 
 

Figure 10-43.  Creating an Address Book View 

     

 
Figure 10-44.  Defining the hierarchy of your Address 
Book View 
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After you define the hierarchy, switch to the Advanced property sheet, shown in  
Figure 10-45.  You need to make a few choices on this property sheet.  The first choice is whether to 
promote entries to parent containers.  If you choose this option and if your hierarchy is at least two levels 
deep, recipients are displayed in all levels that they match. John Smith, for example, would appear in the 
Los Angeles container, the CA container, and the USA container.  If you do not choose the option to 
promote entries to parent containers, recipients appear only at the bottom level that they match. 
 

The second parameter that you can configure on the Advanced property sheet is whether the view should 
be available in the client address book.  Disable this option if you are creating a view that is for 
administrative purposes only; enable it if you want users on your network to have access to the view. 
 
Finally, the Remove Empty Containers button removes from the view any containers in the hierarchy that 
have no recipients in them.  This option can be useful in a large organization. 
 
10.10  OVERVIEW OF EXCHANGE CLIENTS 
 
Up to this point, we have focused on the server portion of the Exchange environment because this book is 
primarily about Microsoft Exchange Server 5.5.  But a server does not operate in a void; clients must be 
attached to the server to complete the picture.  There are seven main types of clients that you may find in 
your Exchange environment.  We will briefly describe each one in this chapter, but will discuss the 
Outlook 98 client in more detail in the next chapter. 
 
The seven main types of clients are: 
 

•  Microsoft Outlook in a variety of service options  
 
•  Microsoft Outlook Express  
 
•  Microsoft Outlook Web Access  

 
Figure 10-45.  Configuring Advanced properties of an 
Address Book View 
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•  Exchange Client  
 
•  Microsoft Schedule+  
 
•  Microsoft Windows messaging client  
 
•  Standard Internet mail clients  

 
10.10.1  MICROSOFT OUTLOOK  
 
Microsoft Outlook 2000 is the latest version of Outlook.  Outlook 2000 is a component of Office 2000, so 
it will become widely used as organizations upgrade to this newest version of the popular office suite. 
Outlook 2000 is included in all five  Office 2000 packages: Microsoft Office 2000 Small Business, 
Microsoft Office 2000 Standard, Microsoft Office 2000 Professional, Microsoft Office 2000 Premium, 
and Microsoft Office 2000 Developer. Figure 10-46 shows an example of the Inbox in Outlook 2000. 
 

 
As you can see, the appearance isn't much different from that of Outlook 98.  However, several new 
features are included in Outlook 2000, including the ability to: 

 
•  Publish your personal or team calendar as a Web page using a single command  
 
•  Use the Capabilities tab on a Contact item to track and view dynamically all activity related to a 

contact such as e-mail, appointments, and tasks  
 
•  Use Mail Merge to manage mass mailings for e-mail, fax, and print distribution for all of your 

contacts or for only those selected based on information contained within a set of contact fields  
 
•  Support not only POP3 and SMTP but also IMAP4, LDAP, NNTP, S/MIME, HTML Mail, 

vCard, and iCalendar  
 
•  Use the Shortcut Bar to create a shortcut for any file, Web page, or folder  
 

 
 

   Figure 10-46.  The Outlook 2000 client 
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•  Use Outlook Today to customize an overview of your e-mail, calendar, and task information in a 
single location for those times to provide a quick look at the events for the day 

 
You can make the customized Outlook Today view the default screen for Outlook 2000, as shown in 
Figure 10-47. 
 
10.10.2  MICROSOFT OUTLOOK 98 
 
Outlook 98 is currently the most widely used client for Exchange Server 5.5. Outlook 98 comes bundled 
with Exchange Server 5.5.  The Outlook client was available for free to all for a short time, and it is still a 
free upgrade for users of Outlook 97.  Outlook 98 can be downloaded from 
http://officeupdate.microsoft.com as long as you are a licensed user of any version of Microsoft Office or 
Exchange Server. 
 
The Outlook products were introduced as Exchange clients with Exchange 5.0.  Outlook combines the 
functionality that was previously contained in both Exchange Client and Schedule+ (both of which are 
described later in this chapter) to deliver a complete messaging, scheduling, and contact management 
solution.  Outlook clients can also work with public folders to share information. 
 
In addition to providing all the functionality that formerly required both Schedule+ and Exchange Client, 
Outlook supports add-ins.  Add-ins are additional program modules that, as their name implies, can be 
seamlessly added to the Outlook environment to extend the functionality of the product.  The Schedule+ 
add-in, for example, provides compatibility between Schedule+ and the Outlook calendar.  The capability 
to use add-ins makes Outlook a strategic product for Microsoft because third-party developers can use 
Outlook as an application development platform. An example of a third-party add-in is Pretty Good 
Privacy (PGP).  This add-in allows the user to send encrypted and signed messages using the PGP 
protocol.  (Don't confuse PGP with the Advanced Security discussed in the last chapter.  PGP does not 
use the Key Management Server for its functionality).  PGP is mainly used for Internet Mail and not 
Corporate Workgroup Mail Figure 10-61 shows the basic Outlook 98 client. 
 
Outlook 98 (as well as Outlook 2000) can be used with the following service options, each of which 
provides a different set of features for use in different circumstances: 

 
Figure 10-47.  Customizing the view of Outlook 
Today 

http://officeupdate.microsoft.com/
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•  Corporate or Workgroup (CW) The Corporate or Workgroup Service option is designed for 

use over a local area network (LAN) with Exchange Server, Microsoft Mail, or another third-
party, LAN-based mail system such as cc:Mail or Lotus Notes.  CW provides the complete set of 
Outlook features.  In CW mode, Outlook 98 provides all the features that are available in the 
other modes and more.  Depending on the mail server you are using the client machine does not 
need to have a personal folder, or *.PST file, in order to operate with this service option, because 
the messages are stored on the server.  However, if users want to maintain a *.PST file, they are 
free to do so.  Users must be aware that the *.PST file exists only on their hard drives; it is their 
responsibility to ensure it is backed up properly to avoid losing mail if the *.PST file becomes 
unusable.  Another important item about *.PST files is that they are not, by default, protected 
from prying eyes.  However, there is an option for users to password-protect files if they so 
desire. 

 
•  Internet Mail Only (IMO) The Internet Mail Only Service option makes Outlook act as an 

Internet mail client.  In this mode, an Outlook 98 user dials in to any server that supports POP3, 
SMTP, or IMAP4 clients to access mail.  Some of the functionality of Outlook, such as the use of 
voting buttons, is unavailable in this mode.  A client machine must have a personal folder, or 
*.PST file, in order to store messages.  

 
•  Stand-alone Information Manager with No E-Mail When you choose to use Outlook 98 in this 

mode, Outlook acts as a stand-alone personal Information Manager in which you can use its 
contact, task, and schedule management features.  You cannot send or receive mail when Outlook 
98 operates in this mode.  Even though the client machine is not utilized for mail, it must have a 
personal folder, or *.PST file, in order to store information used by the other features. 

 
Normally, Outlook 98 is installed with the capability to operate with one of these service options.  The 
Outlook installation program determines which service option of Outlook 98 reproduces the functionality 
to which you are accustomed.  If the Outlook 98 installation procedure detects a previous installation of 
Outlook 97, the procedure assumes that you want the same set of Outlook features and installs Outlook 98 
with the same service option that is present in the existing Outlook 97 setup.  You can change the service 
option after Outlook 98 has been installed, but you may have to install additional components to make the 
service option operational. 
 

 
           
                  Figure 10-48.  The basic Outlook 98 client 
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10.10.3  MICROSOFT OUTLOOK EXPRESS 
 
Outlook Express (Figure 10-49) is a subset of the standard Outlook product.  It supports only POP3-, 
SMTP-, and IMAP-based mail, and it does not provide the groupware-messaging present in its bigger 
brother.  The program allows you to access mail messages, send mail messages, and read Internet 
newsgroups, along with providing other functionality such as Lightweight Directory Access Protocol 
(LDAP). Outlook Express cannot take advantage of most of the collaboration features of an Exchange 
Server. 
 

 
Outlook Express is the mail program that comes with Microsoft Internet Explorer, replacing the previous 
client that was called Internet Mail and News. Outlook Express has also become the default mail reader 
for Microsoft Windows 98 replacing the product known as Windows Messaging, which is described later 
in this chapter. Outlook Express provides support for multiple e-mail accounts so they can all be viewed 
from within one window. Outlook Express also provides the capability for multiple users to have their 
own individual identities for messages, contacts, and tasks. 
 
Outlook Express provides mail services and some basic rules functionality through the Inbox Assistant, 
but it cannot create folders on an Exchange Server or access any Exchange public folders, unless you are 
using IMAP4 on your Exchange Server. In addition to reading normal mail messages, Outlook Express 
can act as a newsreader for Internet newsgroups. Outlook Express can impose some client-side rules for 
handling incoming mail, but you cannot use it to create server-side rules as you can with the Rules 
Wizard in the complete Outlook 98 product. 
 
10.10.4  OUTLOOK WEB ACCESS 
 
Outlook Web Access (OWA) is a way of accessing mail and scheduling information from an Exchange 
Server, just as you would from Outlook, through a standard Web browser, such as Microsoft Internet 
Explorer 3.0 or later and Netscape Navigator 3.0 or later.  The version 3 or later browsers are necessary to 
support the functionality required by HTML 3.2, such as frames, advanced scripting, Secure Sockets 
Layer (SSL) and Java. 
 

 
               
                   Figure 10-49.  Outlook Express 
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OWA is not a client at all, but a set of Active Server Pages that run in the context of Microsoft's Internet 
Information Server (IIS), as shown in Figure 10-50.  These Active Server Pages use collaboration data 
objects (CDOs) as an interface to Exchange services. 
 

 
Figure 10-50.  The architecture of Outlook Web Access 
 
You can install OWA when you install Exchange Server 5.5.  When the Active Server Pages that are used 
to provide OWA access are installed, a user can access several of the functions available through Outlook, 
using the browser.  Users can have access to functionality for basic e-mail, basic calendar and group 
scheduling, basic public folders, and collaborative applications (when the forms have been developed 
with Microsoft Visual InterDev).  Some of the items that are not available when using OWA are: 
 

•  Personal address books (Because it is stored on your workstation)  
 
•  Spell-checking  
 
•  Replied and forwarded flags in list view  
 
•  Message flags and Inbox rules  
 
•  Three-pane view  
 
•  Dragging and dropping to a folder  
 
•  Searching for messages  
 
•  WordMail and Microsoft Office integration  
 
•  Viewing free/busy details  
 
•  Task lists and task management  
 
•  Exporting to DataLink watch or other devices  
 
•  Outlook forms  
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•  Synchronizing local offline folders with server folders  
 
•  Access to your .PST file  

 
Outlook Web Access simulates the look and feel of Outlook 98, as shown in Figure 10-51.  The 
universality of the browser client makes OWA an attractive choice in environments that have a 
widespread mix of clients (such as Windows, Macintosh, and UNIX) and that require a shared messaging 
client.  Outlook Web Access is extremely useful for users, such as information systems staff, who move 
around to different workstations frequently during the day.  They simply check their mail quickly using 
OWA instead of creating a mail profile on each of the workstations! 
 
There is no specific integration between Microsoft Office or Internet Explorer and Outlook Web Access, 
and OWA does not provide any task management capabilities.  OWA does allow users to access 
Exchange public folders and the Exchange Directory. 
 
10.10.5  EXCHANGE CLIENT 
 

 
 

Figure 10-52.  The Exchange client running on Windows NT 
 
Exchange Client, shown in Figure 10-52 on a Windows NT 4.0 machine, delivers many of the functions 
that are inherent in the Exchange system, such as the capability to access public folders.  The Exchange 

 
 
       Figure -10-51.  Outlook Web Access client 
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client does not have scheduling capabilities built into it, so it depends on Schedule+ (covered in the 
following section) to provide this capability. 
 
The Exchange client was the default client for Exchange from the first release of the Exchange product 
until Exchange Server 5.5 was released.  It is available in 32-bit Windows, 16-bit Windows, and 
Macintosh versions.  The Outlook for Macintosh and Outlook for 16-bit Windows versions are not 
comparable feature for feature to the 32-bit Windows version of Outlook.  However, both the Macintosh 
and 16-bit Windows versions do include e-mail, personal calendaring, tasks lists, and group scheduling.  
If you have been using Exchange in your environment for a while, you very well might have Exchange 
Client on some, most, or all of your client machines.  Exchange Client is fully supported by Exchange 
Server 5.5; but it will not be enhanced in subsequent releases of Exchange.  
 
10.10.6  SCHEDULE+ 
 
Schedule+ ((Figure 10-53) was the default program used for scheduling and contact management for 
Exchange until Exchange Server 5.5, in which it was replaced by Outlook. Both Schedule+ 1.0 and 
Schedule+ 7.0 were available in 32-bit Windows, 16-bit Windows, and Macintosh versions.  Users 
moving to Outlook from Schedule+ can import their existing calendar data so nothing is lost in the 
transition. 
 
Schedule+ clients can still be used with Exchange Server 5.5, but Schedule+ will not be enhanced in 
subsequent releases of Exchange.  You can use Schedule+ in an Exchange environment that also includes 
Outlook users.  The two client applications can access the same calendaring information, but Outlook 
provides some additional functionality such as: 
 

•  Journal feature  
 
•  Note feature  
 
•  Integrated contacts  
 
•  Additional views  
 
•  Advanced custom view capabilities  
 
•  Task delegation  
 
•  Advanced printing options  
 
•  Public folder with calendars 
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                                                                      Figure 10-53.  Schedule+ Client 
 

10.10.7  WINDOWS MESSAGING 
 
Windows Messaging was the default-messaging client included with all versions of Windows until 
Windows 98.  You may not have realized that there was a program with this name on your machine; most 
users think of it as simply the Inbox.  The only way that you would have seen the name of the application 
was to pay attention to the splash screen that appeared when you double-clicked on the Inbox icon (Figure 
10-54). 

 
When you installed the Exchange Client on a machine, the Exchange Client automatically replaced the 
Windows Messaging client.  If you did not have Exchange Client installed on the machine, the Windows 
Messaging application displayed a simple e-mail client that could not interface with Exchange Server, as 
shown in Figure 10-55. 
 
As you see in the figure, the default version of Windows Messaging does not include any of the advanced 
features that are available in Exchange Client or Outlook, because it could not interface with Exchange 
Server.  You don't see any public folders or the other folders in your normal mailbox that give you access 
to scheduling capabilities and other features.  You have access only to standard mail messages using 
SMTP or POP3. 

 
 

Figure 10-54.  The splash screen identifying Windows Messaging in Windows NT 
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                                                                 Figure 10-55.  The default e-mail program  
                                                                 for Windows Messaging on Windows NT 
 
In Windows 98, Outlook Express replaced Windows Messaging as the default Windows mail client 
because it is included with Internet Explorer 4.0 (which is integrated into Windows 98). 
 
10.10.8  STANDARD INTERNET MAIL CLIENTS 
 
Because Exchange Server 5.5 supports the POP3 Internet mail standard, any e-mail program that can use 
this protocol can access your Exchange Server.  Most popular e-mail clients today can act as POP3 
clients. 
 
Protocols in Exchange 

                              
Figure 10-56.  Enabling the POP3 protocol for                            Figure 10-57.  Enabling the POP3 protocol for    
an Exchange recipient                                                                  an Exchange site 
 
For generic mail clients to work with Exchange, you have to make sure that the POP3 service is running 
on your Exchange Server.  You can assign this protocol in the Protocols container for a site or a server as 
shown in Figure 10-57, as well as on the Protocols tab of the property sheet for an individual user, as 
shown in Figure 10-56. 
 
By default, the POP3 protocol and the IMAP4 protocol are enabled when you install Exchange Server 
5.5.  You can explicitly disable the protocols at two levels of the hierarchy to limit the use of these 
protocols.  For instance, if you want to enable the POP3 protocol for a site, all of the servers in the site 
automatically support the protocol.  If you want to exclude some of the servers in the site from access 
through the POP3 protocol, you can simply disable it at the site level and enable it for the servers you 
want to make available. 
 
You can use any standard e-mail client to get your messages from Exchange Server 5.5, but you cannot 
use the advanced scheduling features of Outlook.  The IMAP4 protocol is used to access both private and 
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public folders, so a standard Internet e-mail client will allow access to these folders if it supports the 
IMAP4 protocol.  You can configure your Exchange Server as the mail server for a generic e-mail client, 
just as you would configure any other POP3-compliant server. 
 
You might notice a similarity in the description of Outlook Express, the standard Windows Messaging 
client, and the use of a standard Internet e-mail client with Exchange.  All these clients provide essentially 
identical functions as Exchange clients because all of them act as simple POP3 mail clients. 
 
Rules and the Basic Client  
You cannot define server-based rules with any POP3 or IMAP4 client, including the standard Windows 
Messaging client, because the capability to define server-based rules is the exclusive realm of Outlook 
and the Exchange client.  Because many of the rules that you create will be run on the Exchange Server, 
they will still operate correctly with a standard Internet e-mail client. 

 

10.10.9  CHOOSING A CLIENT FOR EXCHANGE 
 
In a philosophical sense, choosing a client for Exchange is easy. Outlook 2000 is the most current version 
of the Outlook client; it provides the greatest amount of functionality, and Microsoft designates it as the 
official client for Exchange.  Outlook 2000 comes bundled with Microsoft Office 2000.  If your 
organization is currently using Office 97, by all means move up to Outlook 98. Outlook 98 is a free 
upgrade to licensed users of Office 97 that comes with Exchange Server Service Pack 1 and Service Pack 
2. Exchange Client and Schedule+ are supported, but they are no longer being enhanced with new 
features.  Standard Internet e-mail clients miss a great deal of the functionality that Exchange provides, 
but they are fast enough to be used efficiently over the Internet and are easier to setup for firewall access. 
 
As they say, however, your mileage may vary.  You may have a large installed base of Exchange clients, 
and upgrading them would be a significant administrative task.  Some or all of the people in your 
organization may already have an e-mail program that they like and, rather than go through the pain of 
change, may choose to forgo the advanced features available with Outlook.  Any of these reasons might 
contribute to a decision to support non-Outlook clients as part of your Exchange environment or to use 
Outlook Web Access. 
 
You may also have such a widespread mix of client platforms that you need to use the most generic client 
possible: the Outlook Web Access client.  Or you may need to use OWA to service the messaging needs 
of some of your users and use the complete Outlook product for other users.  Client machines can also use 
standard Internet POP3 and OWA clients to access your Exchange Inbox over the Internet. 
 
10.11  RESOURCES 
 
Exchange Server 5.5 Administrator’s Companion, Microsoft Press. 
 
10.12  SUMMARY 
 
Exchange Server is a very powerful tool that provides e-mail along with a groupware system, common 
repository of information, a platform for creating interactive applications.  We looked at the different 
types of  containers and the architecture of Exchange Server.  In addition, we learned how to create and 
manage user mailboxes and recipients.  Finally we talked about the different clients that can be used with 
Exchange to include Outlook, Outlook Express, Exchange client, etc. 
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10.13  REVIEW QUESTIONS 
 
1. What are the different structural levels of Exchange Server? 
 
 
 
 
 
 
2. What is the difference between Private, Personal, and Public folders? 
 
 
 
 
 
 
3. What is the utility used to manage Exchange Server? 
 
 
 
 
 
 
4. What are types of recipient objects available in Exchange? 
 
 
 
 
 
 
5. What are the different ways to create mailboxes for Exchange? 
 
 
 
 
 
 
 
6. Name four different Exchange Clients that can be used with Exchange Server 5.5. 
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